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About this publication

The IBM® StoredIQ Administrator Administration Guide describes how to manage the
IBM StoredIQ Administrator application to configure shares, create system infosets,
manage users, target sets, and actions, and create reports.

IBM StoredIQ Platform product library
The following documents are available in the IBM StoredIQ Platform product
library.
v IBM StoredIQ Platform Deployment and Configuration Guide, SC27-6386
v IBM StoredIQ Platform Overview Guide, GC27-6398
v IBM StoredIQ Platform Data Server Administration Guide, SC27-5692
v IBM StoredIQ Administrator Administration Guide, SC27-5688
v IBM StoredIQ Data Workbench User Guide, SC27-5691
v IBM StoredIQ eDiscovery User Guide, SC27-5693
v IBM StoredIQ Policy Manager User Guide, SC27-5694
v IBM StoredIQ Data Script User Guide, SC27-5690

Contacting IBM StoredIQ customer support
For IBM StoredIQ technical support or to learn about available service options,
contact IBM StoredIQ customer support at this phone number:

Support and assistance
v 1-866-227-2068

To e-mail IBM StoredIQ customer support, use this email address:
v storediqsupport@us.ibm.com

For information about how to contact IBM, see the Contact IBM web site at
http://www.ibm.com/contact/us/

IBM Knowledge Center

The IBM StoredIQ publications can be found from IBM Knowledge Center.

PDF publications

The IBM Publication Center site offers customized search functions to help you
find all the IBM publications you need.

Contacting IBM
For general inquiries, call 800-IBM-4YOU (800-426-4968). To contact IBM customer
service in the United States or Canada, call 1-800-IBM-SERV (1-800-426-7378).

For more information about how to contact IBM, including TTY service, see the
Contact IBM website at http://www.ibm.com/contact/us/.
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How to send your comments
Your feedback is important in helping to provide the most accurate and highest
quality information.

Send your comments by using the online reader comment form at
https://www14.software.ibm.com/webapp/iwm/web/signup.do?lang=en_US
&source=swg-rcf.
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Chapter 1. Overview of IBM StoredIQ Administrator

IBM StoredIQ Administrator provides at-a-glance understanding of the different
issues that can crop up in the IBM StoredIQ Platform environment. These views
are unique to the IBM StoredIQ Administrator application, providing an overview
of how the system is running. These views also allow access to various pieces of
information that are shared across applications or allow for the management of
resources in a centralized manner.

The Administrator is the person responsible for managing the IBM StoredIQ
Platform installation at a customer site. This individual has strong understanding
of data sources, harvests, indexes, data servers, jobs, infosets, reports, concepts,
actions, and Mule scripts. This list provides an overview as to how IBM StoredIQ
Administrator works.

Managing Data Servers
Using IBM StoredIQ Administrator, the Administrator can identify what
data servers are deployed, their location, what data is being managed, and
the status of each data server in the system. Volume management is a
central component of IBM StoredIQ Platform. With IBM StoredIQ
Administrator, the Administrator can see:
v What volumes are currently under management
v Which data server is responsible for that volume
v The state of the volume after indexing
v The amount and size of information that is contained by each volume.

Administrators can also add volumes to data servers through this interface.

Administering Harvests
Administrators can initiate the incremental or full harvest of a single
volume through the IBM StoredIQ Administrator user interface without
having to log into IBM StoredIQ Platform Data Server.

Creating System Infosets
System infosets that use only specific indexed volumes can be created and
managed within IBM StoredIQ Administrator. Although infosets are a core
component of IBM StoredIQ Data Workbench, system infosets are created
as a shortcut for users in IBM StoredIQ Administrator.

Managing Users
The user management area allows administrators to create users and
manage users' access to the various IBM StoredIQ Platform applications.

Configuring and Managing Actions
An action is any process upon the data that is represented by the indexes.
Actions are run by data servers on indexed data objects. Any errors or
warnings that are generated as a result of an action are recorded as
exceptions in IBM StoredIQ Data Workbench.

Note: Actions can be created within IBM StoredIQ Administrator and then
made available to other IBM StoredIQ Platform applications such as IBM
StoredIQ Data Workbench.

© Copyright IBM Corp. 2001, 2015 1



Managing Target Sets
Provides an interface that allows the user to set the wanted targets for
specific actions that require a destination volume for their actions.

Creating Reports
Helps you to create reports and upload report packages, helping you to
produce reports about your environment.

Using Auto-classification Models
Deploys natural language processing-based document classification to help
you identify relevant documents in cases when relevance is difficult to
characterize with traditional methods, such as queries and set operations.

Managing Concepts
Helps you to relate business concepts to indexed data.

Managing Mule Scripts
Helps you to create Mule scripts and upload script packages. These Mule
scripts are used by IBM StoredIQ Policy Manager to create policies using
the Automation Workflow.

2 IBM StoredIQ Administrator Version 7.6.0.5: Administration Guide



Chapter 2. Data Servers and Volumes

The Data Servers and Volumes page of IBM StoredIQ Administrator contains the
Data Dashboard, where you see all data currently under management, All Data
Servers tab and the All Volumes tab. When a data server is selected, the System
Status and System Activity panes provide detailed information about the selected
data server.

Data Dashboard

The description of the Data Dashboard fields is listed in the following table.

Table 1. Data Dashboard fields and descriptions

Data Dashboard Description

Total Data
Objects

This field lists the total number of data objects under management.

Total Data Size This field lists the total size of data objects under management.

Number of Data
Servers

This field lists the total number of data servers under management.

Number of
Volumes

This field lists the total number of volumes under management.

All Data Servers

All Data Servers tab lists detailed information about a data server.

Table 2. All Data Servers tab column names and descriptions

All Data Servers
Column Name Description

Data server name Lists the name of the data server.

Status Lists the data server's status, namely Healthy, Vulnerable, Critical,
Unavailable, Under maintenance, Rebooting, or Restarting.

IP address Lists the IP address of the data server.

Data objects Lists the number of data objects that are found on the data server.

Total data object zize Lists the size of the data objects that are found on the data server.

The System Status and System Activity panes provide performance information
on a selected data server. These panels only appear once a data server is selected
and View Details is clicked. The ability to check the status of all deployed data
servers is critical to understanding the system's performance metrics.

Table 3. System Status and System Activity panes field names and descriptions

System Status Field
Name Description

Status Lists the data server's status, namely Healthy, Vulnerable, Critical,
Unavailable, Under maintenance, Rebooting, or Restarting.
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Table 3. System Status and System Activity panes field names and descriptions (continued)

System Status Field
Name Description

Status message Describes the data server's status. Status messages include:

v System and services running.

v System is running but some services are still coming up.

v Some query processes are not running.

v There was a problem with the RAID controller.

v Some services are in error.

v Cannot connect to system and error.

IP address Lists the IP address of the data server.

Software version Lists the installed software version.

DB version Lists the installed database version.

System time Lists the system's time, date, and utilized time zone.

System Activity Field
Name Description

Free RAM memory Denotes the amount of available memory (RAM) for the selected
data server.

Free swap memory Denotes the amount of available swap memory for the selected
data server.

Load average Lists the average process load for the selected data server.

Available space Lists the available space on the selected data server.

Active DB
connections

Lists the number of database connections currently open for the
selected data server.

System uptime Lists the total duration of time for which the data server ran.

All Volumes

The tab provides the detailed information about the volumes.

Table 4. All Volumes tab column names and descriptions

Volumes Column
Name Description

Volume name Lists the name of the volume.

Data server Lists the name of the parent data server.

Type Lists the volume's type, namely Primary, Retention, or Discovery
Export. Primary indicates a primary volume. Retention indicates a
retention volume. Discovery Export indicates a discovery export
volume.

Source type Lists the source or connection type for the volume.

Server name Lists the name of the server where the volume is found.

Data objects Lists the number of data objects that are found on the volume.

Total data object size Lists the size of the data objects in the volume.

Last harvested Denotes the last time that the volume was harvested.
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Select the volume and click View Details, a bottom panel opens with the number
of data objects, total data object size, harvest status, last harvest date and time, and
the harvest type.

Searching for a specific data server
When you have multiple data servers available from which to choose, you can
search for a specific data server instead of using the slider to move through
available options.

Procedure
1. In the Enter key term(s)... text box, enter the name of the data server for which

you want to search, and then click Search. You can enter either the full data
server name or a portion of it. To remove the search term, click the X to the left
of the Enter key terms.... text box. Actions that match the entered search term
are returned.

2. Select a data server from the returned list of servers.
3. View the data server's details by clicking View Details.

Adding a primary volume
A primary volume serves as a primary data source in IBM StoredIQ Platform. You
must have at least one primary volume within your configuration.

Procedure
1. Select Data Servers & Volumes > All Data Servers, select a data server, and

then click Add Volume. The Add Volume dialog box appears.
2. In the Add Volume dialog box, complete these fields.

Table 5. Box volumes: Add Volume dialog box options for primary volumes. For Box volume
prerequisites and configuration information, see “Box volumes: configuration note” on page
15.

Box: Add
Volume dialog
box options Action Notes

Volume type In the Volume type list, select Primary.

Source type Select the server's source type.

Server In the Server text box, enter the fully qualified domain name
of the server from which the volume is available for
mounting. For Box volumes, the server name api.box.com is
automatically entered.

Authenticate
with Box

Before a Box volume can be added, the user must be
authenticated. Click the Authenticate with Box link, sign into
the Box account, and select Grant access.

Assign to Data
Server

In the Assign to Data Server list, select the data server.

Volume Name In the Volume Name text box, enter the common,
user-defined name of this volume.

Include Users Select this option to scope the volume. Regular expressions
are supported.
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Table 5. Box volumes: Add Volume dialog box options for primary volumes (continued). For
Box volume prerequisites and configuration information, see “Box volumes: configuration
note” on page 15.

Box: Add
Volume dialog
box options Action Notes

Indexing
Options

Select the check box for the indexing options that you want
to include:

v Include metadata for contained objects

v Include content tagging and full-text index

These
options
are not
selected
by
default.

Table 6. CIFS volumes: Add Volume dialog box options for primary volumes

CIFS: Add Volume dialog
box options Action Notes

Volume type In the Volume type list,
select Primary.

Source type Select the server's source
type.

Server In the Server text box, enter
the fully qualified domain
name of the server from
which the volume is
available for mounting.

Username In the Username text box,
enter the user name that is
used to connect to and
mount the volume.

Password In the Password text box,
enter the password that is
used to connect to and
mount the volume.

Assign to Data Server In the Assign to Data Server
list, select the data server.

Volume Name In the Volume Name text
box, enter the common name
of this volume.

Share In the Share text box, enter
the share name or this
volume.

Initial Directory In the Initial Directory text
box, enter the name of the
initial directory from which
the harvest must begin.

Indexing Options Select the check box for the
indexing options that you
want to include:

v Include metadata for
contained objects

v Include content tagging
and full-text index

These options are not
selected by default.
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Table 7. CMIS volumes: Add Volume dialog box options for primary volumes

CMIS: Add Volume dialog
box options Action Notes

Volume type In the Volume type list,
select Primary.

Source type Select the server's source
type.

Server In the Server text box, enter
the fully qualified domain
name of the server from
which the volume is
available for mounting.

Port In the Port text box, enter the
port number.

Username In the Username text box,
enter the user name that is
used to connect to and
mount the volume.

Password In the Password text box,
enter the password that is
used to connect to and
mount the volume.

Assign to Data Server In the Assign to Data Server
list, select the data server.

Volume Name In the Volume Name text
box, enter the common name
of this volume.

Use SSL Select the Use SSL check
box.

Service In the Service text box, enter
the service name.

Repository In the Repository text box,
enter the name of the
repository.

Indexing Options Select the check box for the
indexing options that you
want to include:

v Include metadata for
contained objects

v Include content tagging
and full-text index

These options are not
selected by default.

Table 8. Exchange volumes: Add Volume dialog box options for primary volumes

Exchange: Add Volume
dialog box options Action Notes

Volume type In the Volume type list,
select Primary.

Source type Select the server's source
type.
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Table 8. Exchange volumes: Add Volume dialog box options for primary
volumes (continued)

Exchange: Add Volume
dialog box options Action Notes

Server In the Server text box, enter
the fully qualified domain
name of the server from
which the volume is
available for mounting.

If Exchange Online is
selected as the Source Type,
the server name is
automatically entered.

Username In the Username text box,
enter the user name that is
used to connect to and
mount the volume.

Password In the Password text box,
enter the password that is
used to connect to and
mount the volume.

Assign to Data Server In the Assign to Data Server
list, select the data server.

Volume Name In the Volume Name text
box, enter the common name
of this volume.

Server Version In the Server Version list,
select the version of
Microsoft Exchange,
choosing from 2000/2003,
2007, 2010/2013 and
Exchange Online.

Mailbox Server In the Mailbox Server text
box, enter the name(s) of the
mailbox server(s), separated
by commas.

If Exchange Online is
selected as the Server
Version, this option is not
available.

Active Directory Server In the Active Directory
Server text box, enter the
name of the Active Directory
server.

If Exchange Online is
selected as the Server
Version, this option is not
available.

Use SSL To use secure socket layer,
select the Use SSL check
box.

If Exchange Online is
selected as the Server
Version, this option is not
available.

Initial Directory In the Initial Directory text
box, enter the name of the
initial directory from which
the harvest must begin.

Virtual Root In the Virtual Root text box,
the name defaults to the
correct endpoint for the
selected Exchange version.
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Table 8. Exchange volumes: Add Volume dialog box options for primary
volumes (continued)

Exchange: Add Volume
dialog box options Action Notes

Indexing Options Select the check box for the
indexing options that you
want to include:

v Include metadata for
contained objects

v Include content tagging
and full-text index

These options are not
selected by default.

Table 9. FileNet volumes: Add Volume dialog box options for primary volumes

FileNet: Add Volume dialog
box options Action Notes

Volume type In the Volume type list,
select Primary.

Source type Select the server's source
type.

Server In the Server text box, enter
the fully qualified domain
name of the server from
which the volume is
available for mounting.

Port In the Port text box, enter the
port number.

Username In the Username text box,
enter the user name that is
used to connect to and
mount the volume.

Password In the Password text box,
enter the password that is
used to connect to and
mount the volume.

Assign to Data Server In the Assign to Data Server
list, select the data server.

Volume Name In the Volume Name text
box, enter the common name
of this volume.

Object Store In the Object Store text box,
enter the object store.

Connection Type In the Connection Type list,
select either HTTP or
HTTPS.

Path In the Path text box, enter
the appropriate directory
path.

Stanza In the Stanza text box, enter
the appropriate stanza.

Scope In the Scope text box, enter
the appropriate SQL where
clause.
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Table 9. FileNet volumes: Add Volume dialog box options for primary volumes (continued)

FileNet: Add Volume dialog
box options Action Notes

Indexing Options Select the check box for the
indexing options that you
want to include:

v Include metadata for
contained objects

v Include content tagging
and full-text index

These options are not
selected by default.

Table 10. IBM Content Manager volumes: Add Volume dialog box options for primary
volumes

IBM Content Manager: Add
Volume dialog box options Action Notes

Volume type In the Volume type list,
select Primary.

Source type Select the server's source
type.

Server In the Server text box, enter
the fully qualified host name
of the library server
database.

Port In the Port text box, enter the
port used to access the
library server database.

Username In the Username text box,
enter the user name that is
used to connect to and
mount the volume.

Password In the Password text box,
enter the password that is
used to connect to and
mount the volume.

Connection String In the Connection String
text box, enter additional
connection-string parameters.
This is an optional step.

Assign to Data Server In the Assign to Data Server
list, select the data server.

Volume Name In the Volume Name text
box, enter the common name
of this volume.

Repository In the Repository text box,
enter the name of the library
server database.

Server Type In the Server Type list, select
the type of server associated
with the volume. Options
include DB2 and Oracle. By
default, DB2 is selected.
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Table 10. IBM Content Manager volumes: Add Volume dialog box options for primary
volumes (continued)

IBM Content Manager: Add
Volume dialog box options Action Notes

Schema In the Schema text box, enter
the schema for this library
server database.

Remote Database In the Remote Database text
box, enter the name of the
remote database.

Harvest Item Types In the Harvest Item Types
text box, enter the name of
the item types to be
harvested, separated by
commas.

Copy to Item Type The Copy to Item Type text
box can be changed to either
SiqDocument or to be an
empty field. If this field is
left empty, the volume
cannot be used for copy-to
actions.

In this release, the attribute
lengths are increased for
some. For more information,
see “IBM Content Manager
attributes” on page 17.

Indexing Options Select the check box for the
indexing options that you
want to include:

v Include metadata for
contained objects

v Include content tagging
and full-text index

These options are not
selected by default.

Table 11. Livelink volumes: Add Volume dialog box options for primary volumes

Livelink: Add Volume
dialog box options Action Notes

Volume type In the Volume type list,
select Primary.

Source type Select the server's source
type.

Server In the Server text box, enter
the fully qualified domain
name of the server from
which the volume is
available for mounting.

Port In the Port text box, enter the
port number.

Username In the Username text box,
enter the user name that is
used to connect to and
mount the volume.

Password In the Password text box,
enter the password that is
used to connect to and
mount the volume.
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Table 11. Livelink volumes: Add Volume dialog box options for primary volumes (continued)

Livelink: Add Volume
dialog box options Action Notes

Assign to Data Server In the Assign to Data Server
list, select the data server.

Volume Name In the Volume Name text
box, enter the common name
of this volume.

Database In the Database text box,
enter the database name.

Search slice In the Search slice text box,
enter the search slice.

Initial Directory In the Initial Directory text
box, enter the search slice
and name of the initial
directory from which the
harvest must begin.

Indexing Options Select the check box for the
indexing options that you
want to include:

v Include metadata for
contained objects

v Include content tagging
and full-text index

These options are not
selected by default.

Table 12. NewsGator volumes: Add Volume dialog box options for primary volumes

NewsGator: Add Volume
dialog box options Action Notes

Volume type In the Volume type list,
select Primary.

Source type Select the server's source
type.

Server In the Server text box, enter
the fully qualified domain
name of the server from
which the volume is
available for mounting.

Username In the Username text box,
enter the user name that is
used to connect to and
mount the volume.

Password In the Password text box,
enter the password that is
used to connect to and
mount the volume.

Assign to Data Server In the Assign to Data Server
list, select the data server.

Volume Name In the Volume Name text
box, enter the common name
of this volume.
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Table 12. NewsGator volumes: Add Volume dialog box options for primary
volumes (continued)

NewsGator: Add Volume
dialog box options Action Notes

Initial Directory In the Initial Directory text
box, enter the name of the
initial directory from which
the harvest must begin.

Indexing Options Select the check box for the
indexing options that you
want to include:

v Include metadata for
contained objects

v Include content tagging
and full-text index

These options are not
selected by default.

Table 13. NFS volumes: Add Volume dialog box options for primary volumes

NFS: Add Volume dialog
box options Action Notes

Volume type In the Volume type list,
select Primary.

Source type Select the server's source
type.

Server In the Server text box, enter
the fully qualified domain
name of the server from
which the volume is
available for mounting.

Assign to Data Server In the Assign to Data Server
list, select the data server.

Volume Name In the Volume Name text
box, enter the common name
of this volume.

Export In the Export text box, enter
the export name for this
volume.

Initial Directory In the Initial Directory text
box, enter the name of the
initial directory from which
the harvest must begin.

Indexing Options Select the check box for the
indexing options that you
want to include:

v Include metadata for
contained objects

v Include content tagging
and full-text index

These options are not
selected by default.
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Table 14. SharePoint volumes: Add Volume dialog box options for primary volumes

SharePoint: Add Volume
dialog box options Action Notes

Volume type In the Volume type list,
select Primary.

Source type Select the server's source
type.

Server In the Server text box, enter
the fully qualified domain
name of the server from
which the volume is
available for mounting.

Username In the Username text box,
enter the user name that is
used to connect to and
mount the volume.

Password In the Password text box,
enter the password that is
used to connect to and
mount the volume.

Assign to Data Server In the Assign to Data Server
list, select the data server.

Volume Name In the Volume Name text
box, enter the common name
of this volume.

Site URL In the Site URL text box,
enter the site URL of the
SharePoint server.

Initial Directory In the Initial Directory text
box, enter the name of the
initial directory from which
the harvest must begin.

To recurse subsites and
include versioning,
SharePoint volumes must be
added in the IBM StoredIQ
Data Server user interface.
SharePoint volumes added
on the application stack can
be edited on the IBM
StoredIQ Data Server user
interface to include those
options.

Indexing Options Select the check box for the
indexing options that you
want to include:

v Include metadata for
contained objects

v Include content tagging
and full-text index

These options are not
selected by default.

3. Click Save to save your configurations and add the volume.
4. Click the All Volumes tab. Notice that the added volume appears therein,

listed as a primary volume. To harvest this newly added volume, select that
volume and then click Harvest.
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Box volumes: configuration note
Box volumes can be added only from IBM StoredIQ Administrator and have
several configuration prerequisites that must be met.

In Box volumes, the concepts of ownership and access are different than in a
typical computer file system. When data objects are copied to Box, they do not
retain their original owner. Instead, ownership changes to the user performing the
copy of those objects. Additionally, the folder hierarchy of the source volume can
be reproduced, but it is rooted in the home folder of the user. And finally, when
configuring a copy action with Box as the target set, it is a best practice to either
designate a destination directory or select Recreate Directory Structure.

Table 15. Retained Box metadata attributes when copying to Box volumes

File metadata attribute Description Notes

File name Same as source

Description Same as source

Owner Box administrator's user
name

IBM StoredIQ does not
support setting the owner
attribute for Box. When
copying any files, the owner
name is set to that of the Box
administrator's account that
was used to add a Box
volume.

Size Same as source

Created Same as source

Modified Same as source

Note: Box volumes can be added only from IBM StoredIQ Administrator, not from
IBM StoredIQ Data Server. IBM StoredIQ supports copy-to Box using CIFS, NFS
and SharePoint as the source volumes. Additionally, Box Notes cannot be viewed
through the Data Object Viewer in IBM StoredIQ Data Workbench.

These prerequisites must be met when adding a Box volume:
v Every application stack requires a dedicated Client ID. Each Client ID has its

own Redirect URI that points to the IBM StoredIQ application stack. To create
the application, log into your Developer's Box account, click My Apps, and then
click Create Application to get client_id, client_secret, and redirect_uri

v In the Box application, set redirect_uri to https://x.x.x.x/proxy/enamel/1.0/
oauthtokengenerator/box, where x.x.x.x is the hostname/IP address of the
application stack. This is how the user accesses the application stack through a
browser.

v In the Box application, select these Scopes options:
– Read and write all files and folders

– Manage an enterprise

– Manage an enterprise's managed users

– Manage an enterprise's groups

– Manage an enterprise's properties

– Manage an enterprise's retention policies

v Before adding Box volumes, the Client ID, Client Secret, and Redirect URI must
be stored in an application stack oauth.conf file. This file can be found in the
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application stack directory in this location: /etc/siq/oauth.conf. After
modifying the oauth.config file, restart the uwsgi service by logging into the
application stack using Putty and running this command: /siq/bin/monit
restart uwsgi

v Each Client ID must have the As-User capability enabled to allow harvests and
data discovery.

Note: Customers should contact their Box support representative to enable this
permission. They will also need their Client ID.

v The application stack must be configured for SSL access, and it must have access
to the Box authentication endpoint on api.box.com. If the application stack has
been deployed without SSL enabled, run /siq/bin/certcfg and follow the
instructions on the Certificate Configuration screen. Consult the IBM StoredIQ
Deployment and Configuration Guide for more information about SSL
configuration.

v The Application Settings for the Box Enterprise Account must not disable
unpublished applications from accessing the account. Leave the Unpublished
Applications check box clear when configuring Application Settings.

Configuring data-server access for Box volumes
A data server managing a Box volume must have access to api.box.com. In order
to copy custom attributes to Box, you must create a CSV mapping file for the
source-volume attributes.

About this task

IBM StoredIQ supports file system metadata as well as SharePoint attributes. What
follows is an example of the CSV mapping file fields:

Table 16. CSV mapping file fields: example

Source
volume Attribute name Attribute example

SharePoint Created (SharePoint) created_sharepoint

SharePoint Modified (SharePoint) modified_sharepoint

SharePoint Approval status
(SharePoint)

approval_status_sharepoint

SharePoint Author (SharePoint) author_sharepoint

SharePoint Content type
(SharePoint)

content_type_sharepoint

SharePoint Editor (SharePoint) editor_sharepoint

SharePoint Publishing level
(SharePoint)

publishing_level_sharepoint

SharePoint Unique ID (SharePoint) unique_id_sharepoint

SharePoint Version (SharePoint) version_sharepoint

SharePoint Title (SharePoint) title_sharepoint

SharePoint Modified by
(SharePoint)

modified_by_sharepoint

SharePoint Category (SharePoint) category_sharepoint

SharePoint Checked out to
(SharePoint)

checked_out_to_sharepoint
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Table 16. CSV mapping file fields: example (continued)

Source
volume Attribute name Attribute example

SharePoint Virus status
(SharePoint)

virus_status_sharepoint

SharePoint Description
(SharePoint)

description_sharepoint

SharePoint Keywords (SharePoint) keywords_sharepoint

SharePoint Check in comment
(SharePoint)

check_in_comment_sharepoint

System
metadata

Owner source_owner

System
metadata

Group source_group

System
metadata

Object name source_object_name

System
metadata

System path souce_system_path

System
metadata

Container path source_container_path

System
metadata

Accessed date source_accessed_date

System
metadata

Modified date source_modified_date

System
metadata

Created date source_created_date

Procedure
1. Copy the mapping .CSV file to each data server.
2. Change the adminknob configuration on each data server by running this

command: psql -d dfdata -U dfuser
a. Select * from adminknobs where name like box_attribute_mapping_file
b. Update adminknobs using the following SQL: Update adminknobs set

value='/path/to/your/mapping/file' where name =
'box_attribute_mapping_file';

3. Restart services on the data servers.

Note: When a file is copied to Box, the Owner attribute is the Box
Administrator's user name. SharePoint, CIFS, and NFS are supported source
volumes for the copy-to Box action.

IBM Content Manager attributes
In the SiqDocument item type, various attributes are increased when copying to
IBM Content Manager.

In the SiqDocument item type, the length of the following attributes are increased
from 128 to 256 bytes when copying to IBM Content Manager:
v SiqServer

v SiqShare
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v SiqInitialDirectory

v SiqFileName

v SiqContainerPath

v SiqOwner

This change will be handled automatically if you do not already have an
SiqDocument item type in your IBM Content Manager server. However, if this item
type exists, it must be recreated with the new attribute lengths for this change to
take effect.

Note: If you have a working CopyTo IBM Content Manager action running
without issues or if you know that your attribute lengths are not greater than 128
in length, then you can defer this action as you have not encountered the attribute
length issue.

Note: Note that the attribute length is in bytes. The number of actual characters
this length will hold varies based on the database code page that is used. For
example, if ASCII is used, then the number of characters is equal to the number of
bytes. If UTF-8 is used, the number of bytes per character varies depending on the
characters. Without this change, you will see errors if the source attributes for a
copy to IBM Content Manager exceed 128 bytes. If you see these errors, you will
need to perform the actions listed below.

To extend the length of these attributes, perform the following actions:
v If the SiqDocument item type does not exist in the IBM Content Manager server,

create a new IBM Content Manager volume with a CopyTo option to select
SiqDocument. It will create the item type and its attributes with the correct
lengths.

v If SiqDocument item type already exists in the IBM Content Manager server and
you need to fix the attribute length problem, then the administrator should
delete/drop the SiqDocument item type and recreate or update the IBM Content
Manager volume used for copy. This will automatically create the item types and
attributes desired.

Note: Take a back up of the database before dropping and recreating
SiqDocument item type. When you drop the item type, you will permanently
loose all the items (documents) stored in it. If the source documents are still
available, you can run copy again to copy the data back into this item type. If
there are no items in the item type, then this is not an issue.
To drop the SiqDocument item type:
1. Delete all the items in the SiqDocument. Note that this is a permanent delete

and you will lose all of the data.
2. Delete the SiqDocument item type.
3. Delete all the attributes belonging to the SiqDocument

If the item type already exists and contains data you need to keep, and you need
to extend these attributes, this is possible through direct database manipulation.
However, this process is not supported and issues deriving from this would not be
covered by IBM support. If this is desired, services should be employed to make
these database changes.
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Adding a retention volume
A retention volume stores data objects that are placed under retention, meaning
that the object is retained for a specified period.

Procedure
1. Click Data Servers & Volumes > All Data Servers, and then click Add

Volume. The Add Volume dialog box appears.
2. In the Add Volume dialog box, complete these fields:

Table 17. Retention volume options

Add Volume
dialog box
option Action Notes Source type

Volume Type In the Volume Type list, select
Retention.

v CIFS

v NFS

Source Type In the Source Type list, select the
source or connection type.

v CIFS

v NFS

Server In the Server text box, enter the
fully qualified domain name of
the server from which the volume
is available for mounting.

v CIFS

v NFS

Username In the Username text box, enter
the user name that is used to
connect to and mount the volume.

v CIFS

Password In the Password text box, enter
the password that is used to
connect to and mount the volume.

v CIFS

Assign to Data
Server

In the Assign to Data Server list,
select a data server.

v CIFS

v NFS

Volume Name In the Volume Name text box,
enter the common name of this
volume.

v CIFS

v NFS

Share In the Share text box, enter the
share name for this volume.

v CIFS

Export In the Export text box, enter the
export name for this volume.

v NFS

Indexing
Options

Select the check box for the
indexing options that you want to
include:

v Include metadata for contained
objects

v Include content tagging and
full-text index

These options
are not selected
by default.

v CIFS

v NFS

3. Click Save to save your configurations and add the volume. Retention volumes
do not have any data to harvest until a copy to retention runs.

4. Click the All Volumes tab. The added volume appears, listed as a retention
volume.
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Adding a discovery export volume
A discovery export volume contains data that is produced from a discovery export
action. That data is kept so that it can be exported as a load file and uploaded into
a legal review tool.

Procedure
1. Click Data Servers & Volumes > All Data Servers, and then click Add

Volume. The Add Volume dialog box appears.
2. In the Add Volume dialog box, complete these fields:

Table 18. Discovery export volume options

Add Volume
dialog box
option Action Notes Source type

Volume Type In the Volume Type list, select
Discovery Export.

v CIFS

v NFS

Source Type In the Source Type list, select the
source or connection type.

v CIFS

v NFS

Server In the Server text box, enter the
fully qualified domain name of
the server from which the volume
is available for mounting.

v CIFS

v NFS

Username In the Username text box, enter
the user name that is used to
connect to and mount the volume.

v CIFS

Password In the Password text box, enter
the password that is used to
connect to and mount the volume.

v CIFS

Assign to Data
Server

In the Assign to Data Server list,
select the data server.

v CIFS

v NFS

Volume Name In the Volume Name text box,
enter the name of this volume.

v CIFS

v NFS

Share In the Share text box, enter the
share name for this volume.

v CIFS

Export In the Export text box, enter the
export name for this volume.

v NFS

3. Click Save to save your configurations and add the volume.
4. Click the All Volumes tab. The added volume appears, listed as a discovery

export volume.

Viewing details of a data server
Detailed information for any data server or volume can be viewed.

Procedure
1. Click Data Servers & Volumes > All Data Servers, and then click View

Details. The <data server name> Details page appears, showing the All Data
Servers and All Volumes tabs.
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2. Select the All Data Servers tab, select the item for which you want to view its
details, and then click View Details.

Note: To view details for multiple items, press Ctrl and select those items, and
then click View Details.
A summary of the data server's details appears along with the System Status
and System Activity panes. The ability to check the status of all deployed data
servers is critical to understanding the system's performance metrics.

System Status
This pane shows the data server's status, a status message, its IP
address, software version, database version, and the system's time.

System Activity
This pane shows the data server's free RAM memory, its free swap
memory, the load average, the available space, the number of active
database connections and the uptime.

When viewing a data server's details, you can use the Reboot Data Server and
Restart Services buttons.

Viewing details of multiple volumes
Detailed, combined information for multiple volumes can be viewed.

Procedure
1. Click Data Servers & Volumes > All Volumes, and then press and hold the

CTRL key or SHIFT key to select the volumes for which you would like to
view combined detailed information. The Combined Volume Details page
appears, showing the combined details of the selected volumes, including the
number of data objects, the size of the total number of data objects, the number
of data servers, and the number of volumes.

2. Add or remove volumes from the Combined Volume Details view using the
CTRL key. The volume is added or removed, and the Combined Volume
Details view is updated automatically.

Rebooting a data server
Data servers can be rebooted when viewing that data server's details.

Procedure
1. Click Data Servers & Volumes > All Data Servers, and then click View

Details. The <data server name> Details page appears, showing the All Data
Servers and All Volumes tabs.

2. Select the All Data Servers tab, select the data server to reboot, and then click
View Details.

3. Click Reboot Data Server. The Confirm Data Server Reboot window appears,
verifying that you would like to reboot the selected data server.

4. Click Reboot Data Server, and the data server reboots. When the data server is
rebooting, its status is changed to Maintenance Mode, and the status message
is Rebooting-system. All other details appear as N/A until the reboot
completes, at which point the data server's details are once again depicted.

Restarting services
Services on a data server can be restarted when viewing that data server's details.
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Procedure
1. Click Data Servers & Volumes > All Data Servers, and then click View

Details. The <data server name> Details page appears, showing the All Data
Servers and All Volumes tabs.

2. Select the All Data Servers tab, select the data server to restart, and then click
View Details.

3. Click Restart Services. The Confirm Data Server Reboot window appears,
verifying that you would like to restart services on the selected data server.

4. Click Restart Services, and services restart. When the services are restarting, its
status is changed to Restarting, and the status message is one of the following:
v System and services running.
v System is running but some services are still coming up.
v Some query processes are not running.
v There was a problem with the RAID controller.
v Some services are in error.
v Cannot connect to system and error.

All other details appear as N/A until the services restart, at which point the
data server's details are once again depicted.

Removing a volume
Volumes can be deleted from the list of available data sources. Note that volume
deletion can cause data loss in existing infosets or indices that reference the deleted
volumes.

Procedure
1. Select Data Servers & Volumes > All Volumes, and then select the volume you

want to delete.
2. Click Remove Volume. The volume is deleted, removing it from the list of

available volumes.

22 IBM StoredIQ Administrator Version 7.6.0.5: Administration Guide



Chapter 3. Harvests

The Harvests page of IBM StoredIQ Administrator displays the complete list of
harvests, where you see all harvests currently under management

In the Scheduled Harvests list, select from Scheduled Harvests, Current Harvests,
and Completed Harvests. Depending on the option selected, only those harvests in
that category are shown in the List of Harvests table.

The description of the different harvest fields is listed in the following table.

Table 19. List of Harvests fields and descriptions

List of Harvests Description

Name Lists the name of the harvest instance.

Type Lists the type of harvest, either Full or Incremental.

Start time Lists the date and time at which the harvest was initiated.

Owner Lists the owner of the harvest.

Harvesting a volume
By clicking Harvest, an Administrator can initiate a full or incremental harvest of a
primary volume without having to utilize IBM StoredIQ Platform Data Server.

Procedure
1. Click Data Servers & Volumes > All Data Servers > Volume, select the volume

to harvest, and then click Harvest. The Harvest Volume dialog box appears.
2. In the Harvest Name text box, enter a unique name for this harvest.
3. In the Schedule Harvest area, select either of the following options.
v Select Immediate to harvest the volume immediately.
v Click Schedule to schedule a date and time for the harvest to occur. Enter

the date (YYYY-MM-DD) and time in the text boxes.
4. In the Harvest Options area, select Incremental or Full.
v An Incremental harvest only harvests any changes on the selected volume

since its last harvest.
v A Full harvest performs a full harvest of the selected volume, regardless of

when it was last harvested.
5. Click Save, and the volume is harvested.

Searching for a specific harvest
When you have multiple harvests available to choose, you can search for a specific
harvest instead of using the slider to move through available options.

Procedure
1. In the Scheduled Harvests lists, select either Scheduled Harvests, Current

Harvests, or Completed Harvests. Depending on the option that is selected,
only harvests in the selected category are shown in the table.
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2. In the Enter key term(s)... text box, enter the name of the harvest for which
you want to search, and then click Search. You can enter either the full harvest
name or a portion of it. To remove the search term, click the X to the left of the
Enter key term(s).... text box. Harvests that match the entered search term are
returned.

3. Select a harvest from the returned list of harvests.

Stopping a harvest
Harvests that have not yet completed can be stopped.

Procedure
1. In the Scheduled Harvests list, select Current Harvests. The list of harvests

that are currently running opens.
2. Select the harvest that you want to stop and click Stop Harvest. The Confirm

Stopping Harvest window appears.
3. Click Stop Harvest to confirm that the harvest will be stopped and not

completed.

Editing a harvest
Existing harvests can be modified as needed.

Procedure
1. In the List of Harvests page, select the harvest that you want to edit, and then

click Edit Harvest. The Edit Harvest dialog box appears.

Note: Only scheduled harvests can be edited.
2. In the Edit Harvest dialog box, edit the harvest as needed.
3. Click Save to save your changes.

Deleting a harvest
Scheduled harvests can be deleted from the List of Harvests page.

Procedure
1. In the List of Harvests page, select the scheduled harvest that you want to

delete, and then click Delete Harvest. The Delete Harvest window appears.
2. Click Delete to delete the selected harvest. The harvest is deleted from the list

of scheduled harvests.
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Chapter 4. System infosets

System infosets can be created in IBM StoredIQ Data Workbench to allow users to
have a different starting point than the All Data Objects infoset.

System infosets are the basis for user-created infosets. System infosets allow
administrators to select which indexed volumes the infoset can draw upon,
creating a shortcut for IBM StoredIQ Data Workbench users. Actions cannot be run
on system infosets, but only on user-created infosets. Therefore, you must first
create the system infoset here in IBM StoredIQ Administrator and then create a
user infoset that can be acted upon in IBM StoredIQ Data Workbench.

Infosets can be public or private. The administrator determines users' access to
system infosets at the time of creation. The All Data Objects and All System-Level
Objects infosets, which are generated by the application, are set to admin by
default and can be viewed only by an administrator.

Note: System infosets must not be used to manage volumes or indexes.
Additionally, system infosets must be created judiciously. If there are several
system infosets through which a user must cull, the shortcut aspect is removed.

Table 20. Infoset management column names and descriptions

Infoset Management
Column Name Description

Name Lists the name of the system infoset. This name must be unique
against all infosets.

Total objects Lists the total number of data objects that are contained within the
system infoset.

Infoset size Lists size of the system infoset.

In use by Indicates the infosets in which this system infoset is used. If the
system infoset is in use, a link is shown, indicating the number of
infosets by which the system infoset is being used. Click the link to
see which infosets use this system infoset.

Access Indicates whether the system infoset is public or private. If the
system infoset is public, it can be viewed by any user. If the system
infoset is private, it can be viewed by only those users granted
permission by the administrator. If users are granted permission,
the number of users is listed with a hyperlink to the Access
Members modal, which lists the name and role of users who have
access.

Description This column lists the optional description of the system infoset.

Searching for a specific system infoset
When you have multiple system infosets available to choose, you can search for a
specific system infoset instead of using the slider to move through available
options.

Procedure
1. In the Enter key term(s)... text box, enter the name of the system infoset for

which you want to search, and then click Search. You can enter either the full
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system infoset name or a portion of it. To remove the search term, click the X to
the left of the Enter key term(s).... text box. System infosets that match the
entered search term are returned.

2. Select a system infoset from the returned list of system infosets.

Creating a system infoset
System infosets can be created with selected volumes, creating a shortcut for IBM
StoredIQ Data Workbench users.

Procedure
1. Click System Infosets, and then click Create Infoset. The Add System Infoset

dialog box appears.
2. In the Add System Infoset dialog box, complete these fields.

a. In the Infoset Name text box, enter the name of this system infoset.
b. In the Description of Infoset text box, enter a brief description of this

system infoset. This infoset might need to be used by several people, so an
accurate description can be helpful to others.

c. In the Access area, click either Public or Private. The All Data Objects and
All System-Level Objects infosets, which are generated by the application,
can be viewed only by an administrator. System infosets that are created by
an administrator default to public. Public system infosets are visible and
available to all users, including users that will be added at a future time.
For public system infosets, the user list is disabled.

d. For private system infosets, the list of available users becomes active. Select
the users for whom this private infoset can be seen. If no users are selected
for a private system infoset, then only administrators can see that system
infoset because they have administrative rights to every infoset.

Note: Access cannot be edited. It must be determined at the time of infoset
creation.

e. Add volumes to this infoset. In the Available Volumes area, select the
volumes that you want to add to this system infoset, and then click Add. To
remove volumes from the infoset, select the volume in Selected Volumes
and then click Remove.

3. Click Save to save the system infoset. It now appears on the List of Infosets
page.

Editing a system infoset
Existing user-created system infosets can be modified as needed.

Procedure
1. In the List of Infosets page, select the system infoset that you want to edit, and

then click Edit Infoset. The Edit System Infoset dialog box appears.
2. In the Edit System Infoset dialog box, edit the infoset as needed.

Note: Access cannot be edited. It must be determined at the time of infoset
creation.

3. Click Save to save your changes.
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Viewing infosets that use a system infoset
Click the link to view which infosets use the selected system infoset.

Procedure
1. Select the system infoset for which you would like what other infosets use the

system infoset.
2. In the In use by column, click the link. The System infoset modal for the

system infoset appears, listing the infosets that use it.
3. Click Close.

Viewing access members

Procedure
1. Select the system infoset for which you would like to access its members, and

then click the link in the Access column. The Access Members window appears,
listing both the user names and roles of all members of the system infoset.

Note: The columns can be sorted to show members in ascending or descending
order.

2. Click Close.

Deleting a system infoset
System infosets can be deleted from the List of Infosets page if they are not in use
by other infosets. When a system infoset is in use by a direct ancestor of other
infosets, Delete is unavailable for use so that the system infoset cannot be deleted.

Procedure
1. In the List of Infosets page, select the system infoset that you want to delete,

and then click Delete Infoset.

Note: The All Data Objects and All System-Level Objects system infosets
cannot be deleted.
The Delete Infoset window appears.

2. Click Delete to delete the selected system infoset. The system infoset is deleted
from the list of available system infosets.
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Chapter 5. User management

From the User Management page, users can be defined and provided with login
information so that they can use the application stack.

This table lists and describes all of the fields that are seen within the List of Users
page. When a user is selected, that user can be viewed, edited, or deleted.

Table 21. List of Users column names and descriptions

List of Users
column name Description

User name The user name that is assigned to the user

First name The user's first or given name

Last name The user's last or surname

Email address The user's email address. System notifications are sent to this email
address.

Role The user's role. Options include Admin, Data User, Discovery User,
Policy User, or SDK User.

Status The user's status. Options include Active or Inactive.

v Active users can log in and use the product. Active is the default status
for a user.

v Inactive users cannot log in to the product suite because their account
is rendered inactive by the Administrator. When inactive users attempt
to log in, they are notified that their login is invalid and that they must
contact an Administrator.

Last login The date and time of the most recent user login. If the user is not logged
in to the system, N/A is shown.

Viewing your user profile
When you are viewing your user profile, you can see various aspects, including
your assigned roles.

Procedure
1. Within the interface, click the down arrow to the right of your user name, and

then select View Profile. The View Profile window appears, showing various
pieces of data, including your name, role, and email address.

2. To change your password, click Change Password.
3. Click Close to close the View Profile window.

Searching for a specific user
When you have multiple users available to choose, you can search for a specific
user instead of using the slider to move through available options.
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Procedure
1. In the Enter key term(s)... text box, enter the user name of the user for which

you want to search, and then click Search. To remove the search term, click the
X to the right of the Enter key term(s)... text box. Users that match the entered
search term are returned.

2. Select a user name from the returned list of user names.

Creating a user
Within IBM StoredIQ Platform, a user authenticates to and interacts with the
product suite. When a user is created, this user can log in and use the system.

Procedure
1. Click Users, and then click Create User. The Add User - Details dialog box

appears.
2. In the Add User - Details dialog box, complete these fields.

a. In the User name text box, enter the user name of the individual. It is
generally a short, unique name, not the person's full name.

b. In the First name text box, enter the first or common name of the user.
c. In the Last name text box, enter the last or surname of the user.
d. In the Email address text box, enter the user's email address.

Note: Because User name and Email address are unique fields, users can
log in to the system by entering either their email address or their user
name.

e. In the Password text box, enter the password for this user.

Note: Passwords must be at least 8 characters in length and contain at least
one of each of these characters: an uppercase letter, a lowercase letter, a
number, and a special character.

f. In the Re-enter password text box, enter the user's password again.
g. In the Role list, select the user's role. Options include Admin, Data User,

Discovery User, Policy User, or SDK User. A user can be assigned multiple
roles by selecting the check boxes in the role list.

Note: The default option during user creation is Data User.
h. In the Status list, select the user's status. Options include Active or Inactive.

Note: The default option during user creation is Active.
i. Click Save, and the user is created.

The newly created user appears within the User Management page.

Connecting to the LDAP server
Before users can be imported and authenticated from an LDAP or
LDAP-supported authentication system, you must connect to the LDAP server.

Procedure
1. Exit IBM StoredIQ Administrator.
2. Verify that your IBM StoredIQ application stack is upgraded to version 7.6.0.5.
3. In an SSH tool, enter /siq/bin/ldapcfg. The Console window appears.
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4. In the Console window, enter these configuration details.
a. Press the space bar to select Allow External LDAP User. This enables

LDAP.
b. In the LDAP URL text box, enter the IP address of your server.
v For the LDAP URL, enter

ldap://ldap-server-hostname
ldap://<ip-address>

v For SSL mode, enter
ldaps://ldap-server-hostname
ldaps://<ip-address>

c. In the LDAP User text box, enter the LDAP user. For example, enter
cn=user,dc=example,dc=com

d. In the LDAP Password text box, enter the LDAP user's password.
e. In the Base DN text box, enter the base DN. For example, enter

dc=example,dc=com

5. The Console window also contains attribute-mapping details. These fields are
required.

Note: Do not modify these attribute-mapping changes unless your schema is
different. If you have questions about the schema or these changes, contact
your company's LDAP administrator.
a. The First Name text box is automatically filled with givenName.
b. The Last Name text box is automatically filled with sn.
c. The Email text box is automatically filled with mail.
d. The Username text box is automatically filled with cn. This field cannot

contain spaces or special characters. Additionally, it must be a part of your
DN for users to import successfully.

6. Restart the uwsgi using this command: /siq/bin/monit restart uwsgi
7. Check the status using this command: /siq/bin/monit summary
8. Log into IBM StoredIQ Administrator, click Users, and then click Import User.

The list of users imported from the LDAP server is visible within the Import
User dialog box.

Synchronizing the LDAP server and application stack
database

To keep users' details properly synchronized between the LDAP server and
application stack database, a daily synchronization process occurs.

Onboarded users' details in the application stack database can become stale,
meaning that they are not synchronized properly with the LDAP server. In order to
keep users' details properly synchronized between the LDAP server and
application stack database, a recurring background process runs once per day. This
daily task avoids overloading a synchronization request on the LDAP server.
However, the synchronization can also be done manually. For example, if the
administrator wants to update users' details to be in application stack database, she
can run the sync-ldap script manually, and the users' updates are synchronized
immediately from the LDAP server.

Note: During synchronization, only active LDAP users' details are updated. If
LDAP users are deleted from the LDAP server, then those users' details are marked
as inactive in the application stack database.
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This command performs a manual synchronization between the LDAP server and
the application stack database: /siq/bin/sync-ldap

Importing a user
Users can be imported and authenticated from an LDAP or LDAP-supported
authentication systems, enabling enterprise security policy enforcement.

Procedure
1. Click Users, and then click Import User. The Import User dialog box appears.
2. In the Import User dialog box, the User name, First name, Last name, and

Email address text boxes are read-only fields. By default, these field are filled
automatically using content from the LDAP Users.

3. To load a user into the form, select a user from the LDAP Users list. Once a
user has been selected for import, the Save button is enabled. If a user has
already been imported, a message appears, informing you to select another
user.

4. In the Role list, select Admin, Data User, Legal Ops User, Policy User, or SDK
User.

5. In the Status list, select Active or Inactive.
6. Click Save. and then click Close. The Save button resets the Import User dialog

box. To import another user, select that user within the LDAP Users table.
7. Once you have completed importing users, click Save, and then click Close.

Editing an imported user
When editing LDAP imported users, only the user's role and status can be
modified.

Procedure
1. Click Users. In the List of users, select the user to edit, and then click Edit

User. The Edit Imported User dialog box appears. The User name, First name,
Last name, and Email address text boxes are read-only fields.

2. In the Role list, select Admin, Data User, Discovery User, Policy User, or SDK
User.

3. In the Status list, select Active or Inactive.
4. Click Save.
5. Once you have completed modifications, click Save, and then click Close.

Editing a user
You can modify existing users, including their status as needed. You can also
activate the disabled users within IBM StoredIQ Administrator.

About this task

Note: Users become disabled after three failed log-in attempts. It is different than a
user rendered inactive, which can be done only by an administrator.

Procedure
1. Click Users, and then select the name of the user that you want to edit.
2. Click Edit User. The Edit User - Details dialog box appears.
3. In the Edit User - Detail dialog box, modify the fields as needed.
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Note: To modify a user's status, select the wanted, changed status in the Status
list.

Note: If you are an administrator and you are changing a user's password,
click the Send reset password email link.

4. Click Save, and the edited user information is saved.

Viewing details of a user
Basic user information such as first and surname, email address, and role can be
viewed by clicking View Details.

Procedure
1. Within the User Management page, select the name of the user for which you

want to view details.
2. Click View Details, and the View User Details window appears.
3. Within the View User Details window, the following information can be seen:

Option Description

User Name The user name of the selected user.

First Name The first or given name of the selected user.

Last Name The last or surname of the selected user.

Email Address The email address of the selected user.

Role The role of the selected user. A role is a
named collection of permissible activities
within the system. Based on the assigned
role of the selected user, that individual can
or cannot do certain things within the
system.

Status The status of the selected user. Options
include active or inactive.

Last Login The last date and time at which the selected
user logged in to the system.

4. To view the user's access log, click the View access log link. The View Access
History Log window appears, showing the system entries for the selected user.
Within the entries, you see system activities such as successful logins,
unsuccessful logins, when a password was changed. To close the View Access
History Log window, click Close.

Note: These columns can be sorted by clicking the up and down arrows to the
right of the column name.

5. To close the View User Details window, click Close.

Deleting a user
You can delete existing users from the system as needed; however, the log entries
of a deleted user are also deleted. In certain instances, it is a good practice that you
change a user's status.

Chapter 5. User management 33



Procedure
1. Click Users, and then select the name of the user that you want to delete.
2. Click Delete User. The Delete User window appears.

Note: If you opt to delete a user, then any log files that are associated with this
user are also deleted.

3. To confirm that you want to delete the user, click Delete. The confirmation
Delete User window appears, confirming that the user was deleted from the
system.

Changing user passwords
Either the user or the administrator can change passwords. Valid passwords are at
least 8 characters in length and contain at least an uppercase letter, a lowercase
letter, a number, and a special character.

About this task

The password reset interaction can occur in four ways:
v A user clicks the Forgot password link on the login page, leading the user to

change the password.
v A user clicks the Did not receive password details or Changed your email

address link within the login screen from any of the applications.
v Users view their profile and opt to change the associated password.
v An administrator edits a user's profile and opts to reset the associated password.

An email is then sent to the user, forcing individuals to change their password.

Procedure
1. Within the email your received regarding how to change your password, click

the provided link. The Change Your Password dialog box appears.
2. In the Old password text box, enter the previously used password for this user.

Note: If the password entered in this text box does not match the one listed in
the system's database records, a red warning message appears. Reenter the old
password.

3. In the New password text box, enter a new password for this user.
4. In the Re-enter new password text box, type the password again.

Note: The passwords that are entered into the New password and Re-enter
new password text boxes must be identical and meet the system's security
requirements. If the entered data is not identical, a red warning appears.

5. Click Save. A congratulatory message appears, confirming that your password
is changed. Click OK to close the window.

Resetting the user password
User passwords can be set and reset as needed by users and administrators alike.

About this task

There are two ways to reset a password:
v For administrators, click the Send reset password email link in the Edit User

Details window.
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v For users who reset their own passwords, use the following procedure.

Procedure
1. From the application login screen, click the Forgot your password link. The

Reset Password dialog box appears.
2. In the Email Address text box of the Reset Password dialog box, enter the

email address where a link to change the password must be sent. This email
address must be linked with your account in IBM StoredIQ Administrator.

3. Click Submit. A confirmation window appears, stating that an email with
instructions for changing your password was sent.

4. Click OK to close the Reset Password window.

Obtaining a new password
Users occasionally need to obtain new passwords to be able to log in to the
system.

Procedure
1. From the application's login screen, click the Did not receive a password link.
2. Contact your system administrator about obtaining a new password.
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Chapter 6. Action management

Actions represent executable processes that act upon indexed data within data
servers. Use the Action Management page to create and modify actions that are
used by IBM StoredIQ Administrator.

With IBM StoredIQ Administrator, you can create these types of actions:
v Copy: The copy action copies infosets to a target set.

– You can specify the directory structure and security settings for copied data
objects.

– If a data object exists with the same name, then the subsequent data objects
that are encountered are renamed.

v Copy to Retention: The copy to retention action copies data objects from source
volumes to a target set for a specified period.

v Delete: The delete action removes data objects from the source volume.
– Only data objects, not directories, are deleted.
– Use caution when you are deleting data objects.

v Discovery Export EDRM XML: The discovery export action copies data objects
and generates an EDRM XML file for loading into third-party legal review tools.

v Discovery Export DAT: The discovery export action copies data objects and
generates a Concordance DAT file for loading into third-party legal review tools.

v Discovery Export DAT Light: The discovery export action copies data objects
and generates a Concordance DAT (Light) file for loading into third-party legal
review tools.

v Modify Attribute: The modify attribute action simulates setting retention by
manipulating specific attributes on objects.

v Move: The move action moves data objects in an infoset to another volume.
– You can specify the directory structure and security settings for moved data

objects.
– If a data object exists with the same name, then the data object is renamed.
– When the source equals the destination, the move is not allowed.

v Watson Curation: The Watson Curation action copies data objects to the Watson
Curator repository. The Watson Curation action is available in IBM StoredIQ
Policy Manager.

v Step-up Full-Text: The step-up full-text action can be run on an infoset,
providing content to the full-text index for objects that are infoset members.

v Step-up Snippet: The step-up snippet action can be run on an infoset, extracting
and storing text for any data object to which it is applied. These data snippets
are then used by auto-classification. Infosets objects without snippets are not
classified for auto-classification.

Note: When scheduled harvests or policies are run against a data source,
snippets are not updated or generated if they are missing.

Table 22. Actions column names and descriptions

Actions Column
Name Description

Action Name Lists the name of the action.
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Table 22. Actions column names and descriptions (continued)

Actions Column
Name Description

Type Lists the action type, namely Copy, Copy to Retention, Delete,
Modify Attribute, Move, Discovery Export XML, Discovery
Export DAT, Discovery Export DAT Light, Step-up Full-Text,
Step-up Snippet, and Watson Curation.

Last Modified Lists the date and time at which the action was last modified.

Target Set Name Lists the action's destined target set.

Description Lists the action description.

Searching for a specific action
When you have multiple actions available to choose, you can search for a specific
action instead of using the slider to move through available options.

Procedure
1. In the Enter key terms... text box, enter the name of the action for which you

want to search, and then press Search. You can enter either the full action name
or a portion of it. To remove the search term, click the X to the left of the Enter
key terms.... text box. Actions that match the entered search term are returned.

2. Edit, clone, or delete the action as needed.

Creating an action
Actions are processes that are enacted on data objects, which are defined by
infosets. Actions must be defined here in IBM StoredIQ Administrator.

About this task

The step-up snippet and step-up full-text actions are built-in actions, meaning that
no options are provided within the user interface. You cannot create or edit the
step-up snippet or step-up full-text action as they are provided for you as
prepopulated options on the Actions tab.

Procedure
1. Click Actions, and then click Create Action. The Add Action dialog box

appears.
2. In the Add Action dialog box, complete these fields.

a. In the Action Name text box, enter the name of this action.
b. In the Description of Action text box, enter a brief description of this

action. This action might need to be used by several people, so an accurate
description can be helpful to others.

c. In the Action Type list, select the action type.
d. If you are creating a copy, copy to retention, discovery export, modify

attribute, or move action, select a target set from the created actions or
create a new target set. In Target Set, select a target set or click Create a
new target set.

e. Click Next to continue creating the action. Depending on the type of action
that is selected, use the corresponding tables to better understand what
options to select.
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Copy action options Action

Target Set In the Target Set area, select a target set.

Destination Directory In the Destination Directory text box, either
enter a file path or use the list option to
select a previously entered file path.
Note: For the Watson Curation action, the
destination directory is not supported.

Directory Structure In Directory Structure, select the check box
if you want to Recreate directory structure
on destination.

Hashes In Hashes, select the check box if you want
to Compute a hash value for each data
object.

Harvesting In Harvesting, select or clear the check box
for Do not auto-harvest destination volume
after copy.

Email Message Format In the Email Message Format list, select the
format of the email message.

SharePoint User Profile Items In SharePoint User Profile Items, select the
check boxes of application SharePoint items,
including Notes, Libraries, Blog Posts,
Wikis, and Misc.

Copy to Retention action options Action

Target Set In the Target Set area, select a target set.

Hashes In Hashes, select the check box if you want
to Compute a hash value for each data
object.

Harvesting In Harvesting, select the check box to Do
not auto-harvest destination volume after
copy if an automatic harvest of the retention
volume is not wanted. If this option is
selected, then the retention volume can be
harvested with the discover retention
volumes job on the data server.

Email Message Format In the Email Message Format list, select the
format of the email message.

Retention Tag In Retention Tag, enter the key term for the
tag.

Retention Period In Retention Period, enter a number, and
then select Days, Weeks, Months, or Years.

Delete action options Action

Delete Parameters In Delete Parameters, select the check box to
Do not delete data objects that have been
accessed since last harvest.
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Discovery Export EDRM XML action
options Action

Destination Directory In the Destination Directory text box, either
enter a file path or use the list option to
select a previously entered file path.
Note: For the Watson Curation action, the
destination directory is not supported.

Unique ID Prefix and # of Digits In Unique ID Prefix and # of Digits, enter a
unique prefix and then the number of digits
to follow that prefix. For example, if you
enter a prefix of feb2012 with 7 digits, this
entry yields a Unique ID similar to
Feb2012-1234567.

Select the check box to Pad Zeros.

Select the check box to Save a text copy.

Email Message Format In the Email Message Format list, select the
format of the email message.

Limit Export Process Select the check box to Limit Export Process
to and enter the number of data objects.

SharePoint User Profile Items In SharePoint User Profile Items, select the
check boxes of application SharePoint items,
including Notes, Libraries, Blog Posts,
Wikis, and Misc.

Discovery Export DAT action options Action

Destination Directory In the Destination Directory text box, either
enter a file path or use the list option to
select a previously entered file path.
Note: For the Watson Curation action, the
destination directory is not supported.

Unique ID Prefix and # of Digits In Unique ID Prefix and # of Digits, enter a
unique prefix and then the number of digits
to follow that prefix. For example, if you
enter a prefix of feb2012 with 7 digits, this
entry yields a Unique ID similar to
Feb2012-1234567.

Select the check box to Pad Zeros.

Email Message Format In the Email Message Format list, select the
format of the email message.

Limit Export Process Select the check box to Limit Export Process
to and enter the number of data objects.

SharePoint User Profile Items In SharePoint User Profile Items, select the
check boxes of application SharePoint items,
including Notes, Libraries, Blog Posts,
Wikis, and Misc.
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Discovery Export DAT-Light action options Action

Destination Directory In the Destination Directory text box, either
enter a file path or use the list option to
select a previously entered file path.
Note: For the Watson Curation action, the
destination directory is not supported.

Unique ID Prefix and # of Digits In Unique ID Prefix and # of Digits, enter a
unique prefix and then the number of digits
to follow that prefix. For example, if you
enter a prefix of feb2012 with 7 digits, this
entry yields a Unique ID similar to
Feb2012-1234567.
Note: This is a required field.

Select the check box to Pad Zeros.

Email Message Format In the Email Message Format list, select the
format of the email message.

Limit Export Process Select the check box to Limit Export Process
to and enter the number of data objects.

SharePoint User Profile Items In SharePoint User Profile Items, select the
check boxes of application SharePoint items,
including Notes, Libraries, Blog Posts,
Wikis, and Misc.

Modify Attribute action options Action

Action Name In the Action Name, enter the action's name.

Action Type In the Action Type list, select the Modify
Attribute option.

Description of Action In the Description of Action text box, enter
the action's description.

Attribute Type Select from the following options: Read-only
or Read-write.

Move action options Action

Destination Directory In the Destination Directory text box, either
enter a file path or use the list option to
select a previously entered file path.
Note: For the Watson Curation action, the
destination directory is not supported.

Directory Structure In Directory Structure, select the check box
if you want to Recreate directory structure
on destination.

Watson Curation action options Action

Destination Directory In the Destination Directory text box, either
enter a file path or use the list option to
select a previously entered file path.
Note: For the Watson Curation action, the
destination directory is not supported.

Directory Structure In Directory Structure, select the check box
if you want to Recreate directory structure
on destination.
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Watson Curation action options Action

Hashes In Hashes, select the check box if you want
to Compute a hash value for each data
object.

Harvesting In Harvesting, select the check box to Do
not auto-harvest destination volume after
copy if an automatic harvest of the volume
is not wanted.

Collection ID In the Collection ID text box, enter the
name of the collection in Watson Curator.

SharePoint User Profile Items In SharePoint User Profile Items, select the
check boxes of application SharePoint items,
including Notes, Libraries, Blog Posts,
Wikis, and Misc.

3. Click Save to save your changes, click Back to return to the previous page, or
click Cancel to cancel creating the action.

Deleting an action
Existing actions can be deleted from the list of available actions.

Procedure
1. In the List of Actions page, select the action that you want to delete, and then

click Delete Action. The Delete Action window appears.
2. Click Delete to delete the selected action. The action is removed from the List

of Actions page and it is no longer available for use.

Cloning an action
Actions can be cloned or duplicated.

Procedure
1. In the List of Actions page, select the action that you want to clone, and then

click Clone Action. The Clone Action dialog box appears.
2. In the Clone Action dialog box, complete these fields.

a. In the Action Name text box, enter the name of this action.

Note: The name of the cloned action must be different from the name of the
original action.

b. In the Action Type list, select the action type, and then click Next to
continue creating the action.

c. In the Description of Action text box, enter a brief description of this
action.

Note: This action might be used by several people, so the description must
be accurate.

d. The selection that is made in the Action Type list determines what options
are available after you click Next. If you are creating a copy, copy to
retention, discovery export, or move action, select a target set from created
target sets or create a new target set. In Target Set, select a target set or
click Create a new target set.
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e. Click Next. Depending on the type of action that is being cloned, you can
see various options.

3. Click Save to save your changes.

Editing an action
Existing actions can be modified.

Procedure
1. In the List of Actions page, select the action that you want to edit, and then

click Edit Action. The Edit Actions dialog box appears.
2. In the Edit Actions dialog box, edit the action as needed.
3. Click Save to save your changes.
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Chapter 7. Target sets

Some actions require a destination to complete, and a target set represents a
mapping for each data server of the wanted target volume. To copy files, the data
server must know where to copy the file to. Each data server must be configured
with a list of target volumes, such as retention and discovery export volumes.

Target Set Example
Data Server 1 has three retention volumes: Volume A, Volume B, and
Volume C.

Data Server 2 has two retention volumes: Volume B, Volume X, and
Volume Z.

Data Server 3 has two retention volumes: Volume B and Volume Z.

Resulting Copy Action: You would like to create a target set for a copy action
Data Server 1 copies to Volume A.

Data Server 2 copies to Volume X.

Data Server 3 copies to Volume B.

Another user might want to create a target set for a copy action where Data Server
1, Data Server 2, and Data Server 3 copies to Volume B.

Table 23. Target set management columns and descriptions

Target set
column
name Description

Target Set
Name

Lists the name of the target set.

Type Lists the type of the target set, namely Primary, Retention, or Export.

Source Type Lists the target set's source type, for example, CIFS, NFS, or SharePoint.

Volumes Lists the number of volumes in that target set.

Last
Modified

Lists the date and time that the target set was last modified.

Description Lists the description of the target set.

Searching for a specific target set
When you have multiple target sets from which to choose, you can search for a
specific target sets instead of using the slider to move through available options.

Procedure
1. In the Enter key terms... text box, enter the name of the target set for which

you would like to search, and then press Search. You can enter either the full
target set name or a portion of it. To remove the search term, click the X to the
left of the Enter key terms.... text box. Target sets that match the entered search
term are returned.

2. Edit, clone, or delete the target set as needed.
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Creating a target set
Retention, copy, move, and discovery export actions require a named destination to
which data objects can be copied, moved, or exported. Target sets associate data
servers and appropriate volumes, providing your actions with a destination.

Procedure
1. Click Target Sets, and then click Create Target Set. The Create Target Set dialog

box appears.
2. In the Create Target Set dialog box, complete these fields.

a. In the Target Set Name text box, enter a name for this target set.
b. In the Description of Target Set text box, enter a description.
c. In the Type of Target Set list, select the type of this target set, namely

Primary, Retention, or Export.
d. In the Source Type list, select the source type of this target set, namely

CIFS, CMIS, FileNet, IBM Content Manager, NFS, SharePoint.
e. In the Target Set List area, click Add Data Servers. Select a data server and

then click Add to move it to the Target Set List box. Click Done when you
finish adding data servers for the target set. Use the Ctrl key to add or
remove several selections simultaneously. The added data servers appear
within the Target Set List box. Click Add/Remove Data Servers to modify
what data servers appear here.

f. In the Create Target Set dialog box, click the added data server and then
select a volume on that data server. Do this step for each added data server.

3. Click Save to save your configuration changes and create the target set.

Editing a target set
Target sets can be edited, modifying the data servers that are associated with the
target set.

Procedure
1. On the List of Target Sets page, click the name of the target set that you would

like to edit, and then click Edit Target Set. The Edit Target Set dialog box
appears.

2. Edit the target set fields as needed.
3. Click Save to save your changes.

Cloning a target set
Target sets can also be cloned or duplicated.

Procedure
1. On the List of Target Sets page, click the name of the target set that you would

like to clone or duplicate, and then click Clone Set. The Clone Target Set dialog
box appears.

2. Edit the target set fields as needed.

Note: The cloned target set's name must be unique.
3. Click Save to save your changes.

46 IBM StoredIQ Administrator Version 7.6.0.5: Administration Guide



Deleting a target set
Existing target sets can be deleted from the list of available target sets.

Procedure
1. In the List of Target Sets page, select the target set you would like to delete,

and then click Delete Set. The Delete Target Set window appears.
2. Click Delete to delete the selected target set. The target set is removed from the

List of Target Sets page, meaning that it is no longer available for use.
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Chapter 8. Reports

IBM StoredIQ contains a number of default reports and the ability to upload a
report package.

IBM StoredIQ provides features to inventory unstructured data. It can then collect
and evaluate unstructured date, compiling reports and jobs to act on the data
according to an organization's needs. Reports can then be printed and
disseminated, allowing teams to analyze data in an ad hoc manner. New reports
can be added by uploading a report package.

IBM StoredIQ Administrator provides a number of built-in reports, such as
summaries of data objects in the system, storage use, and the number of identical
documents in the system. You can create custom reports, including Query Analysis
Reports for e-discovery purposes, and automatically email report notifications to
administrators and other interested parties. By default, these types of reports are
available.
v Compliance Report
v Content Collector Manifest File CSV Export
v CSV All Audited Object Exports
v CSV Attribute Summary
v CSV Exception List Export
v CSV Infoset Data Object Export
v Data Assessment Report
v Data Topology Report
v Duplication Summary Report
v Overlay Hit Report
v Term Hit Report

Table 24. List of Reports options and descriptions

Report column
option Description

Name Name of the report

Created The date and time at which the report was created

Description A description of the report

Note: For help in customizing IBM StoredIQ reports, contact your technical service
representative.

Searching for a specific report
When you have multiple reports from which to choose, you can search for a
specific report instead of using the slider to move through available options.

Procedure
1. In the Enter key terms... text box, enter the name of the report for which you

would like to search, and then press Search. You can enter either the full report
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name or a portion of it. To remove the search term, click the X to the left of the
Enter key terms.... text box. Reports that match the entered search term are
returned.

2. Select the wanted report.

Creating a report

Procedure
1. Click Reports, and then click Create. The Create Report dialog box appears.
2. In the Create Report dialog box, complete these fields.

a. In the Name text box, enter a name for this report.
b. In the Description text box, enter a description of this report.
c. Click Choose File, and then find and select the appropriate report-package

file.
3. Click Create, and the newly created report is added to the List of Reports page.
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Chapter 9. Auto-classification models

Auto-classification models, also called automated document categorization,
integrates the IBM® Content Classification's classification model into the IBM
StoredIQ Platform infoset-generation process.

IBM Content Classification

IBM Content Classification helps organize unstructured content by analyzing the
full text of documents and emails and applying rules that automate classification
decisions. By managing documents and email, you organize and act on content
every day. IBM Content Classification reduces the burden of manual decision
making that is done by employees by accurately and automatically organizing
information. Embedded with natural language processing and semantic analysis
capabilities, IBM Content Classification determines the true intent of words and
then uses that knowledge to automate decision making. Unlike other classification
systems that are based on rules only, IBM Content Classification combines rules
and contextual analysis to incorporate real-time learning that adapts to changing
business needs. As a result, classification becomes accurate over time.

IBM Content Classification can organize information by policies or keywords. The
classification process not only searches for a single word or phrase, but also
analyzes the entire document. It then distills the main point of the text and assigns
the text to a category. When it analyzes content, IBM Content Classification can
recognize misspellings, abbreviations, jargon, and technical terms.

Accuracy improves over time because the system adapts to the unique nature of
your business by identifying different categories from examples that you provide.
You provide feedback, and a deferred retraining operation adjusts the model and
implements corrections based on that feedback. The accuracy of the classification
results keeps pace with changes in your business.

IBM Content Classification combines this context-based approach with a
rule-based, decision-making approach. The system can identify keywords, patterns,
such as account numbers and phone numbers of case identifiers, and words within
a certain proximity of each other. For example, the system can identify occurrences
of the phrase "Attorney General" in the same sentence as the word "California".
When content that matches a condition in a rule is detected, the action that is
defined for the rule is applied, and the document or email is classified.

Examples of classification applications

You can use IBM Content Classification to achieve various business goals.
v Enterprise content standardization: To support document classification and

taxonomy automation within your content management system, document
properties or metadata can be automatically assigned when the content is
classified. Documents can be automatically moved to the correct enterprise
repository.

v Compliance and records management: Documents and email can be declared as
records when they are classified and placed under the control of record retention
policies and compliance standards.
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v E-discovery readiness: Documents and email can be filtered to ensure that only
items with business value are classified and archived. You can quickly and cost
effectively prepare content for potential legal notices.

v Business process optimization: Automated decision making ensures more
consistent outcomes and reduced costs. With content-based analysis, you
accomplish these actions.
– Insert documents into the workflow of a business plan.
– Reroute email.
– Suggest and apply agent responses within a customer-support center.

Using auto-classification, you can create and update classification models to help
map data within infosets. The step-up snippet action extracts and stores text on
data objects within an infoset. For auto-classification to work, you must use the
step-up snippet action since infoset objects without extracted snippets do not have
auto-classification scores.

The Data Expert can use IBM Content Classification to train a classification model.
The classification model is then registered with IBM StoredIQ Administrator. The
registered classification model can be applied to an existing infoset in IBM
StoredIQ Data Workbench to generate new metadata for the objects in the infoset.
Finally, this metadata can be used in rule-based filters to create new infosets.

Note: To use the IBM StoredIQ Administrator auto-classification function, users
must have a licensed installation of the IBM Content Classification on their
desktop.

Applying the auto-classification feature
To use the auto-classification feature successfully, you must work in both IBM
StoredIQ Administrator and IBM StoredIQ Data Workbench.

Before you begin

Prior to preparing an IBM Content Classification model for import, you must finish
downloading the classification export utility, which must be done only one time.
The export utility is used for each IBM Content Classification model that you want
to import.

About this task

IBM Content Classification works by taking a sample set of documents that you
adjust, constructing a classification model, and then classifying a new document.
The IBM StoredIQ Platform defines the classification model as a decision plan with
at least one knowledge base that is referenced by the decision plan.

Procedure
1. In IBM StoredIQ Administrator, on the Action tab, the step-up snippet action is

created automatically and appears in IBM StoredIQ Data Workbench.
2. In IBM StoredIQ Administrator, create an auto-classification model by

importing a compressed file from IBM Content Classification.
3. In IBM StoredIQ Data Workbench, start the step-up snippet action, which is

available on the Act tab, on an infoset.

Note: The infoset must be a user infoset, not a system infoset.
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4. While still in IBM StoredIQ Data Workbench, apply the wanted
auto-classification enhancement, which is available on the Enhance tab, to the
same infoset.

5. After the enhancement completes in IBM StoredIQ Data Workbench, navigate
to Create > Build Filter and apply the auto-class filter to create a new infoset.

6. Review the results of the newly created infoset.

Data server sizing-configuration guidelines
The inclusion of the IBM Content Classification server on the data server changed
the required memory and processors. Data server sizing-configuration guidelines
are provided here.

To support the auto-classification function, you must increase the virtual machine
settings for processors and memory on data servers to these new minimums:
v Memory: 16 GB
v vCPUs: 4

Required storage on the data server for the extracted text (snippet cache) is
roughly 13% of the size of the uncompressed content, or 130 GB per 1 TB. The size
can vary depending on the object type. The maximum amount of extracted text per
item is configured to not exceed 2 MB by default.

A data server with 2 TB of configured storage can support approximately 10 TB of
managed storage, assuming 50 million data objects with an average size of 200 KB.
Approximately 300 GB is metadata storage with the remaining 1,700 GB
supporting a combination of full text and extracted text.

Downloading the classification export utility
The classification export utility is a one-time-only download that must be installed
before an importing a model.

Procedure
1. In IBM StoredIQ Administrator on the Auto-Classification tab, click Download

Classification Export Utility. The siq-classification-export.zip file is
downloaded.

2. Extract the export utility to the bin directory of your IBM Content Classification
product installation. For Windows, it is typically in the C:\IBM\
ContentClassification\Bin directory.

Building an auto-classification model
Creating rules to find documents that fit differing categories is time-consuming
and requires constant, meticulous adjustments. However, importing a classification
model with sets of training documents helps find other, similar documents.

About this task

Using previously harvested data, you can create an auto-classification model.

Procedure
1. Determine the categories into which you want the auto-classification model to

classify documents.
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2. Using IBM StoredIQ Data Workbench, create a filter for each category to
capture documents that are representatives of the category.

3. For each filter, create an infoset. The members of the resulting infoset become
the "training corpus" for the category.

4. For each infoset, run a copy action with IBM StoredIQ Data Workbench onto a
folder that is accessible by the IBM Content Classification application.

5. Use the IBM Content Classification application to create a decision plan and
knowledge base by importing the training corps that you created.

Note: A classification model consists of one decision plan and at least one
knowledge base, which is a requirement of the IBM StoredIQ Platform
auto-classification feature.

Preparing an IBM Content Classification model for import
You must prepare the IBM Content Classification model for importing into IBM
StoredIQ Platform with the IBM Content Classification tool BundleDPKB.exe.

Before you begin

IBM StoredIQ Platform defines the IBM Content Classification model as a set of a
single decision plan and one or more knowledge bases that are referenced by the
decision plan. You must prepare each classification model for import by bundling
the relevant decision plan and knowledge base with the IBM Content Classification
export utility BundleDPKB.exe.

Note: Before you prepare an IBM Content Classification model for import, you
must finish downloading and installing the classification export utility.

Procedure
1. In a command interface, go to the BundleDPKB installation directory and then

enter cscript.exe ClassificationModelExporter.vbs <location of decision
plan projects and knowledge bases> <decision plan directory> <optional
empty directory> <optional zip file name>. If you did not specify a directory
to which the compressed file must be exported, an export directory is created
in the <location of decision plan projects and knowledge bases> location.

2. Note the location and name of the generated compressed file.

Importing an auto-classification model
You must complete these tasks before you can import an auto-classification model.

Before you begin
v Download the classification export utility. The procedure must be done only one

time.
v Prepare the IBM Content Classification model for import. This procedure must

be completed for every model you want to import.

About this task

To import a classification model, go to the Auto-classification tab of the IBM
StoredIQ Administrator. The tab displays the already imported models as
described in this table.
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Table 25. Classification model column names and descriptions

Classification
model column
name Description

Classification
model name

Lists the name of the classification model.

Attribute name Lists the name of the attribute that is used by the classification model.

Status Lists the classification model's status, specifically Available, or
Pending.

Creation date Lists the date and time at which the classification model was created.

Description Lists the description of the classification model.

Procedure
1. Within IBM StoredIQ Administrator, click Create Model. The Create Model

dialog box appears.
2. In the Classification Model Name text box, enter a unique name for this

auto-classification model.
3. In the Attribute Name text box, enter a unique name for this attribute. The

Attribute Name must be unique within auto-classifications as it cannot be
changed after the classification model is imported.

4. In the Description text box, enter a description of this model.
5. In the Auto-Classification Model File text box, click Browse and select the

classification model file that you want to use when you are creating the model.
Generally, this file is a compressed file that is created in the classification export
utility. It consists of elements that are created in IBM Content Classification by
the Data Expert.

6. Click Save, and the newly created model appears in the list of classification
models.

Selecting a classification model
By selecting a classification model, you can view the details of that model,
including the status of the last retrain, how much feedback it has received, and
how many infosets have been enhanced using this model.

Procedure
1. Within IBM StoredIQ Administrator, click Auto-Classification. The List of

Classification Models page appears.
2. Select the model for which you would like to view greater detail. The <model

name> Details panel appears.

Note: The <model name> Details panel appears by default. However, if you
close the panel but then later want to view details about that model again, click
View Details.
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Table 26. Row names and descriptions of the <model name> Details panel

Row name Description

Status Lists the classification model's status, specifically Available,
Defunct, Deleting, Failed, Invalid, Pending, Processing, or
Retraining.
Note: In the Processing or Retraining states, models cannot
be edited.

Last retrained Lists the date and time this classification model was last
retrained.

Last retrain status Lists the classification model's retrain status. Status messages
are Success, Failed, and N/A.

Total feedbacks Lists the number of times the model has received feedback.

Total feedbacks after last
retrain

Lists the number of times this model received feedback after
its last retrain date.

Total infosets created using
this model

Lists the number of infosets that use this classification model.

Total infosets enhanced by
this model

Lists the number of infosets that have been enhanced by this
classification model.

3. To close the <model name> Details panel, click Close.

Searching for a specific classification model
When you have multiple classification models to choose, you can search for a
specific classification model instead of using the slider to move through available
options.

Procedure
1. In the Enter key terms(s) text box, enter the name of the classification model

for which you want to search, and then press Search. You can enter either the
full classification model name or a portion of it. To remove the search term,
click the X to the left of the Enter key term(s) text box. Classification models
that match the entered search term are returned.

2. Edit, delete, or retrain the classification model as needed.

Editing a model
The terms and formats that are associated with a particular classification model
change over time, which means that the classification model must also change.
Classification models can be edited or updated, modifying the model file that is
associated with that particular classification model.

Procedure
1. On the Auto-classification tab, click the name of the classification model that

you want to edit, and then click Edit Model. The Edit Model window appears.
2. Edit the classification model fields as needed.

Note: Attribute names cannot be changed, but you can edit the name of the
model without specifying a new model (.ZIP) file. If you attempt to modify a
classification model that is being used, a warning appears. Click OK to return
to the List of Classification Models page.

3. Click Save to save your changes.
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Deleting a model
Existing classification models can be deleted from the list of available models, if it
was not used to enhance an infoset and that infoset still exists.

Procedure
1. In the List of Classification Models page, select the classification model that

you want to delete, and then click Delete Model. The Delete Model window
appears.

2. Click Delete to delete the selected model. The classification model is removed
from the List of Classification Models page. It is no longer available for use.

Retraining a classification model
Data models are deployed regularly against data sets. Once a classification model
is deployed within IBM StoredIQ, it can be applied against millions of data objects
as opposed to the few hundred that were used for the initial training of the model.
By applying the model to so many data objects, it gives you much more granular
data points. Because it takes time and effort to "train" or prepare a classification
model against a set, data experts' positive or negative feedback is useful in
retraining a classification model. Is the model working satisfactorily? Where does
the model not seem to function well? Are there inconsistencies? Data experts have
intimate knowledge of particular data sets and classification models, and they can
provide positive and negative feedback regarding a model's accuracy. This
feedback can be used to reinforce or improve a model's behavior, thereby allowing
you to retrain the model to improve its accuracy.

Before you begin

With the assistance of IBM Software Support, modify the data learning settings.
1. Click Project > Project Options. The Project Options dialog box appears.
2. In the Project Options window, click Advanced. The Advanced Project Options

window appears.
3. Select the Maintain learning data set with knowledge base option. Accept all

other default values.
4. Click OK.

The data-learning settings can also be modified in the Create, Analyze, and Learn
dialog box by clicking Settings. For more information, see http://www-
01.ibm.com/support/knowledgecenter/SSBRAM_8.8.0/
com.ibm.classify.workbench.doc/c_WBG_Saving_Learning_Data.htm.

Procedure
1. Create a classification model. In IBM StoredIQ Administrator, click Create

Model to create a classification model. You must set an attribute when creating
a classification model.

2. Create a user infoset. In IBM StoredIQ Data Workbench, create a user infoset,
and then select that user infoset so that it is active.

3. Run the step-up snippet action. In IBM StoredIQ Data Workbench, run the
snippet step-up action on the newly created user infoset.

4. Apply an enhancement. In IBM StoredIQ Data Workbench, select an
enhancement to apply to the newly created user infoset, and then click Run
Enhancement.
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5. Apply a filter. In IBM StoredIQ Data Workbench, create a filter.
a. Select the Auto-classify option.
b. In the list below the Auto-classify option, select the classification model for

which results should be filtered.
c. Select the categories. By default, the Category option is selected, as are all of

the available categories.
d. Determine how the results will be displayed, selecting either And the

highest score in the selected category or And where the score <is/Greater
than/Less than/Not equal/Greater than or equal/Less than or equal> <1>.

6. View the objects in the Data Object Viewer. Click Preview Filter Results, and
the objects are displayed in the Filter Results area. Select one of the returned
objects to view it in the Data Object Viewer.

7. Provide feedback for this data object. Click the button to the right of Auto-class
Scores. This displays the list of categories and the object's score for each
category. The category with the highest score is listed at the top. As the Data
Expert, select the categories to which the selected data object belongs. Data
objects with a value closer to one (1) are more closely associated with that
category. Data objects with a value closer to zero (0) are not closely associated
with that category. Click Submit. This feedback helps to improve the accuracy
and validity of the classification model. Repeat this step for as many different
data objects as you like. The number of feedback submissions can be seen
within the <model name> Details panel in IBM StoredIQ Administrator.

8. In IBM StoredIQ Administrator, click Auto-Classification and select the
classification model. Note that the <model name> Details panel shows that it
has received feedback. Click Retrain to launch the retrain process for this
model. If the model was uploaded without a learning archive (SARC file) or if
it has received no feedback, then the Retrain button is disabled.

9. Run the enhancement against the infoset again, noting the new scores within
the Data Object Viewer. The improved scores indicate greater validity and
accuracy.
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Chapter 10. Concept management

Within IBM StoredIQ Platform, you can use the concept-management feature to
relate business ideas to indexed data.

When you are using IBM StoredIQ Administrator, you use infosets, run actions,
generate reports, and more generally, interact with IBM StoredIQ Platform as a
whole. These technical aspects of using IBM StoredIQ Administrator are designed
for more technical users. Concepts are designed for the business user and provide
a user experience of creating a filter that finds documents that are owned by a
particular user name, for example. This use of the product is oriented towards
solving business problems. Using the product typically requires the user to
translate business concepts like identity, department, vendor, and project into the
various technical concepts of the product, such as filters and infosets.

A concept defines and represents an identity, custodian, vendor, and project that
can be related to indexed data in a meaningful way. It is a set of attributes that
describe and distinguish individual concept members. For example, an employee
concept might define the attribute's user name, given name, surname, and email
address.

Concept members are the granular building blocks of a concept. When concept
members are defined, they can be gathered into groups for aggregate use.

The Identity concept is created as a predefined, preconfigured concept available
within IBM StoredIQ eDiscovery.

The List of Concepts screen is simple, depicting concepts, identities, and aspects.
From here, you can search for, delete, edit, and add identities.

Table 27. Concept columns and descriptions

Concept Column
Name Description

First name Lists the given name.

Last name Lists the surname.

Email address Lists the email address.

Owner ID Lists the owner identification number.

Company Lists the member's company name.

Department Lists the department of the member.

Adding a member to a concept
Members can be added to existing concepts.

Procedure
1. Click Concepts.
2. From the list, select the type of concept you would like to add, and then click

Create Member. The Identity concept was created as a predefined,
preconfigured aspect. The Add Identity dialog box appears.

3. In the Add Identity dialog box, complete these fields.
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a. In the First Name text box, enter the identity's given name.
b. In the Last Name text box, enter the identity's surname.
c. In the E-mail Address text box, enter the identity's email address.
d. In the Company text box, enter the name of the company that is associated

with this identity.
e. In the Department text box, enter the name of the identity's department.
f. In the Owner ID text box, enter the identity's owner ID.

4. Click Cancel to cancel adding an identity and return to the List of Concepts
screen, or click Save to save the added member and return to the List of
Concepts page.

Searching for a concept
When you have multiple concepts available to choose, you can search for a specific
concept instead of using the slider to move through available options.

Procedure
1. In the Enter key terms... text box, enter the name of the concept for which you

want to search, and then press Search. You can enter either the full concept
name or a portion of it. To remove the search term, click the X to the left of the
Enter key terms.... text box. Concepts that match the entered search term are
returned.

2. Edit or delete the concept as needed.

Editing a member of a concept
Existing concepts and their members can be modified.

Procedure
1. From the List of Concept page, select the concept that you want to edit, and

then click Edit. The Identity concept was created as a predefined,
preconfigured aspect. The Edit Identity dialog box appears.

2. Edit the concept member and click OK to save your changes.

Deleting a member of a concept
Existing concept members can be deleted from the list of available concepts.

About this task

If you delete a member of a concept, existing filters that use that concept's
members are affected.

Procedure
1. From the List Concepts page, select the concept member that you want to

delete, and then click Delete. The Delete Confirmation window appears.
2. Click OK to delete the selected concept member. The member of the concept is

removed from the table and is no longer available for use.
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Chapter 11. Mule scripts

Using the Mule Script tab, administrators can upload the Mule archive from their
local directories. Mule archives are externally authored scripts, which are used by
the IBM StoredIQ system to automate workflows.

This table lists and describes all of the fields that are seen within the Available
Scripts page. When a Mule script is selected, it can be viewed in greater detail,
edited, or deleted.

Table 28. Mule script columns and descriptions

Mule script
column
name Description

Name Lists the name of the Mule script.

Created Lists the creation date and time of the Mule script.

Script
package

Lists the name of the Mule script package.

Description Lists the description of the Mule script.

Note: For information regarding how to set up the IBM StoredIQ environment to
work with Mule Anypoint Studio and Mule scripts, see Appendix A, “IBM
StoredIQ Mule script,” on page 65.

Creating a Mule script
Created Mule scripts are available for use from the Mule Scripts page.

Procedure
1. Click Mule scripts, and then click Create. The Create Script dialog box appears.
2. In the Create Script dialog box, complete these fields. Newly created Mule

scripts cannot be saved until these fields are complete.
a. In the Name text box, enter the name of the Mule script.
b. In the Description text box, enter a description of this newly created Mule

script.
c. Click Choose File, and then navigate to and select the script package file.

The name of the selected script package file appears to the right of the
Choose File button.

d. Click Create, and Mule script appears within the list of available Mule
scripts. Once Mule scripts are available within the Available Script list, the
Delete, Edit, and View Details buttons are active.

Searching for a specific Mule script
When you have multiple Mule scripts available to choose, you can search for a
specific Mule script instead of using the slider to move through available options.
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Procedure
1. In the Enter key term(s)... text box, enter the name of the Mule script for which

you want to search, and then click Search. You can enter either the full Mule
script name or a portion of it. To remove the search term, click the X to the left
of the Enter key term(s).... text box. Mule scripts that match the entered search
term are returned.

2. Select a Mule script from the returned list of scripts.

Viewing details of Mule scripts
Detailed information for any Mule script can be viewed.

Procedure
1. In Available Scripts, select the Mule script for which you would like more

information, and then click View Details. The Script Details pane appears at
the bottom of the page, providing detailed information about that Mule script.

Name Lists the name of the Mule script.

Created
Lists the creation date and time of the Mule script.

Script Package
Lists the name of the script package. By clicking the link, you can open
a browser and download the file.

Endpoint URL
Lists the endpoint URL.

Description
Lists a description of the Mule script.

Used by
Lists the policies that use the Mule script.

2. Click Close to close the Script Details pane.

Editing a Mule script
Existing Mule scripts can be modified as needed.

Procedure
1. In the Available Scripts page, select the Mule script that you want to edit, and

then click Edit. The Edit Script dialog box appears.
2. In the Edit Script dialog box, edit the Mule script as needed.
3. Click Save to save your changes.

Deleting a Mule script
Existing Mule scripts can be deleted from the Available Scripts page.

About this task

Mule scripts that are being used by policies cannot be deleted, and deleted Mule
scripts are not available for newly created policies. To see what policies use a Mule
script, review the Used By section within the Script Details.
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Procedure
1. In the Available page, select the Mule script that you want to delete, and then

click Delete. The Confirm Deletion window appears.
2. Click Delete Script to delete the selected Mule script. The Mule script is

deleted from the list of available scripts.

Importing the IBM StoredIQ application stack SSL certificate
For the Mule Standalone engine to work with the SSL-enabled IBM StoredIQ
application stack, you must first import your IBM StoredIQ application stack SSL
root certificate to the JRE used by the Mule Standalone engine.

Before you begin

Verify that your application stack is updated to the most recent version.

Procedure
1. Locate the JRE used by the Mule Standalone engine. It is located at

/siq/env/java/jre.
2. Import the SSL root certificate /etc/siq/ssl/root.crt into

/siq/env/java/jre/lib/security/cacerts.
3. Save the cacerts file.
4. Restart Mule using this command: /siq/bin/monit restart mule
5. Check status using this command: /siq/bin/monit summary
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Appendix A. IBM StoredIQ Mule script

IBM StoredIQ Policy Manager allows the policy users to create automation
workflow policies from its dashboard by using Mule Script. Mule Script is used to
enable data automation for IBM StoredIQ custom services. Before this type of the
policy can be added to the dashboard of the IBM StoredIQ Policy Manager, a user
who understands the customer's needs and requirements must help create the
automation flow with Mule Script through Mule Anypoint Studio.

From the user interface of Anypoint Studio, the Mule scripts can be edited, tested,
imported, and exported.

After Mule scripts are created, the administrator uses the IBM StoredIQ
Administrator user interface to manage the Mule scripts to get them ready for the
policy user to create policies.

For information about how to use the Mule products, see documentation on the
official website of MuleSoft Inc.

Setting up Mule Anypoint Studio with IBM StoredIQ
Mule Anypoint Studio is a graphic design environment that provides functions of
creating, editing, testing, importing, and exporting Mule scripts. You must set up
the Mule Anypoint Studio environment before you can create Mule scripts.

About this task

Follow these steps to set up the Mule Anypoint Studio environment.

Procedure
1. Select the correct operating system and then download Mule Anypoint Studio

from https://www.mulesoft.com/lp/dl/studio
2. Install and start Mule Anypoint Studio.

a. Extract the installation files into the local directory.
b. Double-click AnypointStudio.exe to start Mule Anypoint Studio.
c. Choose the workspace location to work with this tool.

3. Set up the Java environment from Windows > Preferences > Java > Installed
JREs. Ensure that it points to JRE7 or JDK7.

4. Install Mule Runtime Community Edition (CE). By default, Mule Anypoint
Studio is packaged with Enterprise Engine (EE), which has a 30-day license.
You need to install Community Engine with the free license to create the flow
with Mule Anypoint Studio.
a. From Help > Install New Software, enter http://studio.mulesoft.org/r4/

studio-runtimes.
b. Select and install Mule Server 3.6.1 CE.

5. Install the Mule StoredIQ Connector.
a. From Help > Install New Software, enter the URL of the connector update,

http://{StoredIQ_appStack host}/mule-connector-update, to install
Community/StoredIQ Connector (Mule 3.5.0+).
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b. Verify that the StoredIQ Connector is installed, create a Mule project, and
type storediq in the search box of the right window. A new icon StoredIQ
displays.

c. Drag this connector to construct StoredIQ scripts. You can see a list of
operations with the corresponding parameters in the Basic Settings window.

6. Install the storediq_domain project. For more information, see “Importing a
domain project in Anypoint Studio” on page 71.

Note: The storediq_domain is used to share the HTTP inbound endpoint across
different StoredIQ Mule scripts. The shared listening port is 8081. All IBM
StoredIQ Mule Scripts must be associated with storediq_domain to use this
shared HTTP port. Download storediq_domain.zip from http://
{StoredIQ_appstack host}/download/mule-flows/storediq_domain.zip. Import
the domain project into Mule Anypoint Studio.

7. Create a Mule project.
a. Select New > Mule Project.
b. Enter the name of the Mule project and select Mule Server 3.6.1 CE as the

Runtime engine.
c. Associate Mule Projects with storediq_domain. See “Associating a Mule

project with a domain project” on page 71.
d. Drag the icons from the search box to create a Mule script with the HTTP

endpoint.

Note: You can test the Mule project within Mule Anypoint Studio.
8. Export the Mule projects to the Mule archive, that is, script package. This Mule

archive can be passed to IBM StoredIQ administrator, who checks in Mule
scripts to IBM StoredIQ Administrator.
a. Click Export to export the existing Mule project into archive.
b. Clear Export parent domain project.
c. Save the archive as a .zip file in the local directory.

9. Import the Mule projects from the Mule archive. If you want to modify an
existing Mule script, you can download the Mule archive from
http://{StoredIQ_appstack host}/download/mule-flows/<mule script>.zip,
and then import the Mule archive into Mule Anypoint Studio.

Importing the IBM StoredIQ application stack SSL certificate
For Mule Anypoint Studio to work with the SSL enabled IBM StoredIQ application
stack, you must first import your IBM StoredIQ application stack SSL root
certificate to your local SDK.

Before you begin

Make sure that your application stack is updated.

Procedure
1. Download the SSL root certificate file from IBM StoredIQ application stack, for

example, /etc/siq/ssl/root.crt, to your local directory.
2. Check the version of JRE that is used by Mule Anypoint Studio.
3. Use keytool to open the cacerts file under <JRE>/lib/security folder.
4. Import the SSL root certificate into the cacerts file and save the cacerts file.
5. Restart Mule Anypoint Studio.
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Mule script management
For information about use of Mule platform, see Mule documentation from its
official website.

Mule script restrictions

You must follow these rules when you work with the Mule scripts:
v Mule scripts must have an inbound end-point http with the storediq_domain

shared port 8081. For example, http://localhost:8081/mule_policy1.
v Mule scripts should have a readme file that provides details about the script.

This readme file is written by the user and meets these criteria:
– Must be in the .pdf format and its file name can be accessible by URL.
– Shows the diagram, description, and input data, if needed
– Is put under the top level of the Mule archive

v Mule scripts may require input data. If so, that input data must be in the .JSON
format. For example,
{

"sysinfoset_id": "d8242a7e-2658-4ca9-bf27-d54f30dae085",
"filter_id": "48e225fb-b9d0-4ce4-9706-636c0832b1f1",
"report_id": "00000000-0000-0000-0000-000000001000"

}

IBM StoredIQ Connector operations
You can construct a Mule script with the IBM StoredIQ operation blocks.

For a complete list of IBM StoredIQ operations, their parameters, and descriptions,
see Appendix B, “IBM StoredIQ Connector operations,” on page 73.

Creating the IBM StoredIQ Mule script
Use Mule Anypoint Studio to create the IBM StoredIQ Mule script.

Before you begin

Before you use a Mule script to access the IBM StoredIQ resources, you must
authenticate to the IBM StoredIQ application stack server. You must configure three
parameters for authentication:
v StoredIQ application stack host
v StoredIQ application stack user name
v StoredIQ application stack password

You can use either of the following ways to configure connections to the IBM
StoredIQ application stack server:
v Select the Global Mule Configuration Elements tab from Mule script. Click

Create and search for storediq.
v Drag an IBM StoredIQ connector in the Mule script. Click the + sign to the left

of Connector Configuration. Type the value of the IBM StoredIQ host, user
name, and password. Click Test Connection to ensure that the authentication is
successful.
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Note: The authentication is valid for all IBM StoredIQ connectors within the same
flow.

Procedure
1. Search and delete IBM StoredIQ resources.

a. Enter a name in the Display Name field. For example, list dataservers.
b. Select Search from the Operation list.
c. Select dataserver from the Resource Type list.
d. Enter information in the Search option for specific resources.
e. To delete the selected resources, select the Delete the resource checkbox.

2. Create and harvest the data source.
v To create a data source:

a. Enter a name in the Display Name field, for example, create nfs
datasource.

b. Select StoredIQ from Connector Configuration.
c. Enter the parameters for Name, for example, mule_datasource,

DataServer Id, for example, UUID of the data server, and select the type.
v To harvest a data source:

a. Enter a name in the Display Name field, for example, harvest
datasource.

b. Select StoredIQ from the Connector Configuration list.
c. Select Harvest datasource from the Operation list.
d. Enter the parameters for Name, for example, mule_harvest, DataSource

Ids, for example, UUID of the data source, and select Harvest Type and
Load Type from the lists.

e. Select Wait for Completion under Flag.
3. Create a system infoset.

a. Enter a name in the Display Name field. For example, create system infoset.
b. Select StoredIQ from Connector Configuration.
c. Select Create system infoset from Operation.
d. Enter the parameters for Infoset Name. For example, mule_sys_infoset.
e. Enter the parameter for DataSource Ids. For example, UUID of the data

source.
f. Select Wait for Completion under Flag.

4. Create a filter.
a. Enter a name in the Display Name field. For example, create user filter.
b. Select StoredIQ from Connector Configuration.
c. Select Create filter from Operation.
d. Enter the parameters for the filter name. For example, mule_filter.
e. Enter the expression: att:”/Library/Attributes/System

metadata/Extension” IS any (“txt”) IN all.
5. Create a user infoset.

a. Enter a name in the Display Name field. For example, create user
infoset.

b. Select StoredIQ from Connector Configuration.
c. Select Create user infoset from filter from Operation.
d. Enter the parameters for Infoset Name. For example, mule_user_infoset.
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e. Enter Filter Id. For example, UUID of the filter.
f. Enter the Infoset Source Ids. For example, a list of UUID of the infoset

sources, which are separated by commas.
g. Select Wait for Completion under Flag.

6. Create a target set.
a. Enter a name in the Display Name field. For example, create targetset
b. Select StoredIQ from Connector Configuration.
c. Select Create targetset from Operation.
d. Enter the parameters for Name. For example, mule_targetset.
e. Enter the parameter for DataSource Ids. For example, UUID of the data

source.
f. Select primary as its Type.

7. Create an action.
a. Enter a name in the Display Name field. For example, create action.
b. Select StoredIQ from Connector Configuration.
c. Select Create action copy plain from Operation.
d. Enter the parameters for Name. For example, mule_action.
e. Enter the parameter for TargetSet Id. For example, UUID of the target set.

8. Run an action.
a. Enter a name in the Display Name field. For example, run action.
b. Select StoredIQ from Connector Configuration.
c. Select Execute action from Operation.
d. Enter the parameters for Name. For example, mule_execution_action.
e. Enter the parameter for User Infoset Id. For example, UUID of the user

infoset.
f. Enter the parameter for Action Id. For example, UUID of the action.

9. Generate a report.
a. Enter a name in the Display Name field. For example, generate report.
b. Select StoredIQ from Connector Configuration.
c. Select Generate report from Operation.
d. Enter the parameters for Name. For example, mule_report.
e. Enter the parameter for User Infoset Id. For example, UUID of the user

infoset.
f. Enter the parameter for Report Id. For example, UUID of the report action.

Note: If you select Wait for Completion, the StoredIQ flow waits for the report
to be successfully generated and then returns the report URL in the result
string. If you do not select Wait for Completion, the StoredIQ flow does not
wait for completion of the report generation and the result string does not
contain the report URL.

Deploying the Mule script
Mule Standalone Engine is preinstalled in IBM StoredIQ application stack. It hosts
the Mule scripts without Mule Anypoint Studio.

About this task

Use these commands to start or stop the engine:
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/siq/bin/monit start mule
/siq/bin/monit stop mule

When the engine is up and running, use the following steps to deploy or undeploy
the Mule script.

Procedure
1. Export the Mule script from Anypoint Studio into an archive file in the .zip

format. For example, mule_helloworld.zip
2. Write a readme file to explain the Mule script diagram. Provide a description

and example input data in the .pdf format and with the same name as the
Mule script. For example, mule_helloworld.pdf.
A readme file can look like the following example.
Description:
This Mule script creates a user infoset from the system infoset and filter and
then it generates a report. The unique ID of the system infoset, filter, and report
can be passed in from the input file in the .json format.
Example of input data:
{

"sysinfoset_id": "d8242a7e-2658-4ca9-bf27-d54f30dae085",
"filter_id": "48e225fb-b9d0-4ce4-9706-636c0832b1f1",
"report_id": "00000000-0000-0000-0000-000000001000"
}

3. Save this readme file into the Mule archive file that was created in Step 1.
4. Pass the Mule script archive file to the administrator of IBM StoredIQ

Administrator. For example, mule_helloworld.zip.
5. The administrator can create a Mule script with the provided Mule archive

from IBM StoredIQ Administrator. See Creating a Mule script. After the Mule
script is created successfully, it is automatically deployed into Mule Standalone
Engine.

6. When the administrator deletes an existing Mule script from IBM StoredIQ
Administrator user interface, the Mule script is automatically undeployed from
Mule Standalone Engine.

Results

The Mule script log traces the Mule script process. It is in the /siq/env/mule/logs
directory.

Configuring Mule script timeout lengths
By default, the Mule script timeout value is 432000, or five days. This value can be
modified by administrators.

About this task

By default, the Mule script timeout value is 432000, or five days. This value can be
modified by administrators.

Procedure
1. Verify that your IBM StoredIQ application stack is upgraded to the most recent,

supported version.
2. In an SSH tool, enter /siq/bin/mulecfg. The Console window appears.
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3. In the Console window, the Mule Script timeout (seconds) parameter is
shown. Modify the default value of 432000.

4. Press Tab to select Save or Save and exit, and then press Enter.
5. Restart the uwsgi using this command: /siq/bin/monit restart uwsgi
6. Check the status using this command: /siq/bin/monit summary

Mule domain project
Mule defines selected connectors as common resources and they are accessible to
all applications that are deployed under the same domain. These resources are
known as shared resources.

To use these shared resources, you must associate the Mule project with the Mule
domain project, then reference the shared resource in the Mule project.

The following sections use HTTP Listener Connector as an example to demonstrate
how to share HTTP host and listener port across different Mule projects.

Importing a domain project in Anypoint Studio
The following procedure uses storediq_domain.zip as an example to describe how
to import a Mule domain project.

Procedure
1. From Anypoint Studio, right-click Package Explorer, and from the menu select

Import > Anypoint Studio > Anypoint Studio-generated Deployable archive
(.ZIP).

2. Specify the location of storediq_domain.zip, and then click Finish. The
mule-domain-config.xml file displays automatically. The shared resource
http:listner-config is defined inside.

Associating a Mule project with a domain project
Follow these steps to associate any new or existing Mule project with the domain
project.

Procedure
1. Select an existing Mule project that has an HTTP listener connector as the

inbound endpoint. Open the project's Mule configuration xml file and select the
proper domain under Runtime > Domain. For example, in Mule project, open
mule-project.xml and then select storediq_domain as the domain.

Note: You can add multiple Mule projects under the same domain, but you can
associate only one project with one domain at a time.

2. In the Mule project, directly refer to a connector configuration in the HTTP
listener connector. For example, in Mule project, use HTTP_Listener_storediq
from the domain project storediq_domain without creating a new HTTP listener
configuration.

3. Use the path value in the HTTP listener connector to differentiate Mule projects
that share the host and port within the same domain.
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Appendix B. IBM StoredIQ Connector operations

The following table provides information about IBM StoredIQ Connector
operations, their parameters, and descriptions.

Table 29. IBM StoredIQ Connector operations

Connector operation Parameter Description

createFilter filter_name Name of the filter

description Description of the filter

expression Expression of the filter

createSystemInfoset infoset_name Name of the infoset

description Description of the infoset

datasource_ids List of data source IDs
separated by commas

access_type Access type of infoset, either
public or private

user_list List of user IDs that can be
accessed to the infoset

waitforCompletion Flag to indicate sync and async

createUserInfosetFromFilter infoset_name Name of the infoset

description Description of the infoset

infoset_id ID of the infoset source

filter_id ID of the filter

overlays Overlay filter IDs separated by
comma

notify Notification mail

generate_datamap Flag to indicate whether a
datamap is generated

waitforCompletion Flag to indicate sync or async

createUserInfosetByOperations operations Infoset operations

infoset_name Name of the infoset

description Description of the infoset

sources List of source infoset IDs
separated by commas

overlays Overlay filter IDs separated by
commas

notify Notification email

generate_datamap Flag to indicate whether a
datamap is generated

waitforCompletion Flag to indicate sync or async
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Table 29. IBM StoredIQ Connector operations (continued)

Connector operation Parameter Description

createUserInfosetFromExceptions infoset_name Name of the infoset

description Description of the infoset

infoset_id ID of the infoset source

event_ids Event IDs separated by
commas

categories Category names that are
separated by commas

overlays Overlay filter IDs separated by
commas

notify Notification email

generate_datamap Flag to indicate whether a
datamap is generated

waitforCompletion Flag to indicate sync or async

createTargetset targetset_name Name of the target set

description Description of the target set

type Type of the target set

datasource_ids Data source IDs separated by
comma

createDatasourceNfs datasource_name Name of the data source

dataserver_id ID of the data server

datasource_type Type of the data source

nfs_server NFS server IP or host name

nfs_export NFS server export directory

scoping_information_initial_directory NFS server initial directory

scoping_information_include_directories NFS server include directories

index_options_container_metadata Include metadata for contained
objects

index_options_full_text_content Include content tagging and
full-text index

createDatasourceCifs datasource_name Name of the data source

dataserver_id ID of data server

datasource_type Type of the data source

cifs_server CIFS server IP or host name

cifs_username CIFS server user name

cifs_password CIFS server password

cifs_shared CIFS server share directory

scoping_information_initial_directory CIFS server initial directory

scoping_information_include_directories CIFS server include directories

index_options_container_metadata Include metadata for contained
objects

index_options_full_text_content Include content tagging and
full-text index
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Table 29. IBM StoredIQ Connector operations (continued)

Connector operation Parameter Description

createDatasourceCm8 datasource_name Name of the data source

dataserver_id ID of data server

cm8_server CM8 server IP or host name

cm8_port CM8 server port

cm8_username CM8 server user name

cm8_password CM8 server password

cm8_repository CM8 server repository

cm8_dbtype CM8 server remote DB type

cm8_remotedb CM8 server remote DB

cm8_schema_name CM8 server schema name

cm8_connection_string CM8 server connection string

scoping_information_initial_directory CM8 server initial directory

scoping_information_include_directories CM8 server include directories

index_options_container_metadata Include metadata for contained
objects

index_options_full_text_content Include content tagging and
full-text index

createDatasourceCmis datasource_name Name of the data source

dataserver_id ID of the data server

cmis_server CMIS server IP or host name

cmis_port CMIS server port

cmis_username CMIS server user name

cmis_password CMIS server password

cmis_use_ssl Boolean value to indicate ssl or
not

cmis_service CMIS server service

cmis_repository CMIS server repository

index_options_container_metadata Include metadata for contained
objects

index_options_full_text_content Include content tagging and
full-text index
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Table 29. IBM StoredIQ Connector operations (continued)

Connector operation Parameter Description

createDatasourceExchange datasource_name Name of the data source

dataserver_id ID of the data server

exchange_server Exchange server host name

exchange_username Exchange server name

exchange_password Exchange server password

exchange_active_directory_server Exchange server active
directory server

exchange_use_ssl Exchange server use SSL flag

exchange_version Exchange server version

exchange_folder Exchange server folder

exchange_mailbox_server Exchange server mailbox server

exchange_personal_archive Exchange server personal
archive

scoping_information_initial_directory Exchange server initial
directory

scoping_information_include_directories Exchange server include
directories

index_options_container_metadata Include metadata for contained
objects

index_options_full_text_content Include content tagging and
full-text index

createDatasourceSharepoint datasource_name Name of the data source

dataserver_id ID of the data server

sharepoint_server SharePoint server host name

sharepoint_port SharePoint server port

sharepoint_username SharePoint server user name

sharepoint_password SharePoint server password

sharepoint_use_ssl SharePoint server use SSL flag

sharepoint_active_directory_server SharePoint server active
directory server

sharepoint_site_url SharePoint server site URL

scoping_information_initial_directory SharePoint server initial
directory

scoping_information_include_directories SharePoint server include
directories

index_options_container_metadata Include metadata for contained
objects

index_options_full_text_content Include content tagging and
full-text index
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Table 29. IBM StoredIQ Connector operations (continued)

Connector operation Parameter Description

createDatasourceLivelink datasource_name Name of the data source

dataserver_id ID of the data server

livelink_server Livelink server IP or host name

livelink_port Livelink server port

livelink_username Livelink server user name

livelink_password Livelink server password

livelink_database Livelink server database

livelink_search_slice Livelink server search slice

scoping_information_initial_directory Livelink server initial directory

scoping_information_include_directories Livelink server include
directories

index_options_container_metadata Include metadata for contained
objects

index_options_full_text_content Include content tagging and
full-text index

createDatasourceFilenet datasource_name Name of the data source

dataserver_id ID of the data server

filenet_server FileNet server IP or host name

filenet_port FileNet server port

filenet_username FileNet server user name

filenet_password FileNet server password

filenet_connectionType FileNet connection type

filenet_path FileNet server path

filenet_stanza FileNet server stanza

filenet_object_store FileNet server object store

filenet_wheresql FileNet sql where clause

filenet_domain FileNet server domain

filenet_create_document FileNet server create document
flag

scoping_information_initial_directory FileNet server initial directory

scoping_information_include_directories FileNet server include
directories

index_options_container_metadata Include metadata for contained
objects

index_options_full_text_content Include content tagging and
full-text index
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Table 29. IBM StoredIQ Connector operations (continued)

Connector operation Parameter Description

createDatasourceNewsgator datasource_name Name of the data source

dataserver_id ID of the data server

newsgator_server NewsGator server host name

newsgator_username NewsGator server user name

newsgator_password NewsGator server password

newsgator_use_ssl Boolean value to indicate ssl or
not

index_options_container_metadata Include metadata for contained
objects

index_options_full_text_content Include content tagging and
full-text index

harvestDatasource harvest_name Name of harvest

datasource_id ID of the data source

harvest_type Type of harvest

load_type Type of load

schedule Harvest schedule

waitforCompletion Boolean value to indicate sync
or async

generateReport report_name Name of the report

user_infoset_id ID of the user infoset

action_id ID of the report

terms List of terms that are separated
by commas for Term Hit
Report only

filter_ids List of filter IDs that are
separated by commas for Term
Hit Report only

execution_id ID of execution for Audit
Summary Report only

notify Notification email

waitforCompletion Boolean value to indicate sync
or async

executeAction execution_name Name of the action

user_infoset_id ID of the user infoset

action_id ID of the action

waitforCompletion Boolean value to indicate sync
or async

cancelExecution id ID of execution
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Table 29. IBM StoredIQ Connector operations (continued)

Connector operation Parameter Description

createActionCopyPlain action_name Name of the action

description Description of the action

targetset_id Target set ID

destination_path Destination path

copy_sharepoint_userprofile_notes Boolean value to copy
SharePoint user profile notes

copy_sharepoint_userprofile_libraries Boolean value to copy
SharePoint user profile libraries

copy_sharepoint_userprofile_posts Boolean value to copy
SharePoint user profile posts

copy_sharepoint_userprofile_wikis Boolean value to copy
SharePoint user profile wikis

copy_sharepoint_userprofile_misc Boolean value to copy
SharePoint user profile misc

compute_hash_value Boolean value to compute the
harsh value

recreate_directory_structure Boolean value to re-create
directory structure

no_auto_harvest Boolean value to indicate that
there is no auto harvest

createActionCopyRetention action_name Name of the action

description Description of the action

targetset_id Target set ID

retention_type Type of retention

retention_value Retention value

retention_tag Tag of retention

compute_hash_value Boolean value to compute hash
value

no_auto_harvest Boolean value to indicate that
there is no auto harvest
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Table 29. IBM StoredIQ Connector operations (continued)

Connector operation Parameter Description

createActionDiscoveryExportEdrmxml action_name Name of the action

description Description of the action

targetset_id Target set ID

destination_path Destination path

data_object_limit Data object limit

copy_sharepoint_userprofile_notes Boolean value to copy
SharePoint user profile notes

copy_sharepoint_userprofile_libraries Boolean value to copy
SharePoint user profile libraries

copy_sharepoint_userprofile_posts Boolean value to copy
SharePoint user profile posts

copy_sharepoint_userprofile_wikis Boolean value to copy
SharePoint user profile wikis

copy_sharepoint_userprofile_misc Boolean value to copy
SharePoint user profile misc

unique_document_id_prefix Unique document ID prefix

unique_document_id_digits Unique document ID digits

unique_document_id_pad_digits Boolean value to unique
document ID pad digits

save_text_copy Boolean value to save the text
copy

email_item_disposition Email item disposition

createActionDiscoveryExportDat action_name Name of the action

description Description of the action

targetset_id Target set ID

destination_path Destination path

data_object_limit Data object limit

copy_sharepoint_userprofile_notes Boolean value to copy
SharePoint user profile notes

copy_sharepoint_userprofile_libraries Boolean value to copy
SharePoint user profile libraries

copy_sharepoint_userprofile_posts Boolean value to copy
SharePoint user profile posts

copy_sharepoint_userprofile_wikis Boolean value to copy
SharePoint user profile wikis

copy_sharepoint_userprofile_misc Boolean value to copy
SharePoint user profile misc

unique_document_id_prefix Unique document ID prefix

unique_document_id_digits Unique document ID digits

unique_document_id_pad_digits Boolean value to unique
document ID pad digits

email_item_disposition Email item disposition
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Table 29. IBM StoredIQ Connector operations (continued)

Connector operation Parameter Description

createActionDiscoveryExportDatLight action_name Name of the action

description Description of the action

targetset_id Target set ID

destination_path Destination path

data_object_limit Data object limit

copy_sharepoint_userprofile_notes Boolean value to copy
SharePoint user profile notes

copy_sharepoint_userprofile_libraries Boolean value to copy
SharePoint user profile libraries

copy_sharepoint_userprofile_posts Boolean value to copy
SharePoint user profile posts

copy_sharepoint_userprofile_wikis Boolean value to copy
SharePoint user profile wikis

copy_sharepoint_userprofile_misc Boolean value to copy
SharePoint user profile misc

unique_document_id_prefix Unique document ID prefix

unique_document_id_digits Unique document ID digits

email_item_disposition Email item disposition

createActionWatsonCuration action_name Name of the action

description Description of the action

targetset_id Target set ID

destination_path Destination path

collection_id Collection ID

copy_sharepoint_userprofile_notes Boolean value to copy
SharePoint user profile notes

copy_sharepoint_userprofile_libraries Boolean value to copy
SharePoint user profile libraries

copy_sharepoint_userprofile_posts Boolean value to copy
SharePoint user profile posts

copy_sharepoint_userprofile_wikis Boolean value to copy
SharePoint user profile wikis

copy_sharepoint_userprofile_misc Boolean value to copy
SharePoint user profile misc

compute_hash_value Boolean value to compute hash
value

recreate_directory_structure Boolean value to recreate
directory structure

no_auto_harvest Boolean value to indicate that
there is no auto harvest

createActionExportExceptions action_name Name of the action

description Description of the action

export_format Export format
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Table 29. IBM StoredIQ Connector operations (continued)

Connector operation Parameter Description

createActionModifyAttribute action_name Name of the action

description Description of the action

attribute Modification type

createActionMovePlain action_name Name of the action

description Description of the action

targetset_id ID of the target set

destination_path Destination path

recreate_directory_structure Boolean value to re-create a
directory structure

createActionMoveRetention action_name Name of the action

description Description of the action

targetset_id ID of the target set

retention_type Type of the retention

retention_value Retention value

createActionDeleteNodes action_name Name of the action

description Description of the action

ignore_accessed_objects Boolean to ignore accessed
objects

search resourceType Type of the resource

id ID of the resource

nameOptions Name search options

resource_name Name of the resource

status Status of the resource

max Maximum number of the result
to be returned

delete Flag to indicate whether the
resource is to be deleted
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Notices

This information was developed for products and services offered in the U.S.A.
This material may be available from IBM in other languages. However, you may be
required to own a copy of the product or product version in that language in order
to access it.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
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sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
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platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows: © (your company name) (year). Portions of
this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp.
2004, 2010. All rights reserved.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Privacy policy considerations
IBM Software products, including software as a service solutions, (“Software
Offerings”) may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings
can help enable you to collect personally identifiable information. If this Software
Offering uses cookies to collect personally identifiable information, specific
information about this offering’s use of cookies is set forth below.

[Depending upon the configurations deployed, this Software Offering may use
[session] [and] [persistent] cookies that collect each user’s [name,] [user name,]
[password,] [profile name,] [position,] or [other personally identifiable information]
for purposes of [session management,] [authentication,] [enhanced user usability,]
[single sign-on configuration] [or other usage tracking or functional purposes.]
These cookies [cannot be disabled] [can be disabled, but disabling them will also
[likely] eliminate the functionality they enable].

If the configurations deployed for this Software Offering provide you as customer
the ability to collect personally identifiable information from end users via cookies
and other technologies, you should seek your own legal advice about any laws
applicable to such data collection, including any requirements for notice and
consent.

For more information about the use of various technologies, including cookies, for
these purposes, See IBM’s Privacy Policy at http://www.ibm.com/privacy and
IBM’s Online Privacy Statement at http://www.ibm.com/privacy/details the
section entitled “Cookies, Web Beacons and Other Technologies” and the “IBM
Software Products and Software-as-a-Service Privacy Statement” at
http://www.ibm.com/software/info/product-privacy.

Terms and conditions for product documentation
Permissions for the use of these publications are granted subject to the following
terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the IBM
website.
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Personal use

You may reproduce these publications for your personal, noncommercial use
provided that all proprietary notices are preserved. You may not distribute, display
or make derivative work of these publications, or any portion thereof, without the
express consent of IBM.

Commercial use

You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make
derivative works of these publications, or reproduce, distribute or display these
publications or any portion thereof outside your enterprise, without the express
consent of IBM.

Rights

Except as expressly granted in this permission, no other permissions, licenses or
rights are granted, either express or implied, to the publications or any
information, data, software or other intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its
discretion, the use of the publications is detrimental to its interest or, as
determined by IBM, the above instructions are not being properly followed.

You may not download, export or re-export this information except in full
compliance with all applicable laws and regulations, including all United States
export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at "Copyright and
trademark information" at http://www.ibm.com/legal/copytrade.shtml

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

Java™ and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.
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UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, and service names may be trademarks or service marks
of others.
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